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Introduction

Overview

The Power Tab Editor is a tablature authoring tool for Windows 95/98. It allows for the creation of music
scores in both standard and tablature notation that can be printed out and played back via MIDI.

Requirements

Microsoft® Windows 9x, NT 4.0, 2000 *●   

Microsoft® Common Controls version 4.70 or greater●   

Microsoft® Internet Explorer 3.0 or higher **●   

Microsoft® HTML Help files **●   

Adobe Acrobat Reader 3.0 or higher ***●   

Pentium 166 Mhz or greater ****●   

32MB RAM ****●   

* The program has not been throughly tested on any version of Microsoft® NT/2000.  I do not have access to these products so I have
no way to verify program runnability at present time.  Several users have reported that it works fine on these products.

** These components are needed to view the Power Tab Editor .chm help file.  If you're using Windows 98 or higher, you have all the
necessary files to open the help file. The latest common controls can be downloaded here. (50comupd.exe).

*** This component is required to view the Power Tab Editor .pdf help file.  The reader is freeware and can be found at www.adobe.com

**** The CPU and RAM requirements were the setup used on the computer that the program was built on. The program has not been
tested on a setup with lower values than these, it does not mean that the program will not run on these machines.

http://support.microsoft.com/support/kb/articles/q186/1/76.asp
http://www.adobe.com/
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What's New?

Version History

 

Version 1.7 - August 30, 2000

 

Additions

New Open Dialog - Displays information about a Power Tab file without having to open it■   

Page Setup implemented - Allows changing of paper size within the program.  Currently
does not save paper size though. (must be reset each time program runs) 

■   

Mousewheel functionality implemented - Mousewheels can be used to jump from section
to section

■   

Adobe Acrobat Help File (.pdf) - You no longer need to have IE 4/5 installed to view help■   

 

❍   

Updates

Song Attributes changed to File Information - The information now differentiates
between songs and lessons.

■   

 

❍   

Fixes

Autosave Feature bug fixed - Autosave was not updating itself properly after changing
the autosave time.

■   

Save bug fixed - Program was asking to save file, when nothing had changed in file.■   

Printing bug fixed - Program was not printing properly on non 8.5 x 11in paper.■   

Tremolo bar bug fixed - The 4 step dip was incorrectly displayed as 3 in the tremolo bar
dialog box

■   

Rehearsal Sign/Music Bar bug fixed - When updating a music bar that had a rehearsal
sign at the same position, the alignment would go out of wack.

■   

❍   

●   

Version 1.5 - May 22, 2000

Additions

Several new hot keys added for accessing common features■   

Alteration of Pace functionality implemented. This allows for gradual tempo
changes to occur.

■   

Added Copy Special Position. (Edit Menu -> Copy Special -> Copy Position) This
copies the current position to the clipboard

■   

Music Bar hot spot added (music staff only) - It is now possible to edit a music
bar by clicking on the music bar in the music staff

■   

Double sharps and flats are now used when necessary on the music notation
staves

■   

Sections can now be exported to bitmap format (either to clipboard or to file)■   

Octave signs implemented (8va, 15ma, 8vb and 15mb)■   

Added 2 Tab Notation Options, display "Full" or "1" for both bends/tremolo bars■   

"Not Released" added to list of Released On types in Song Attributes■   

Song Fade In/Out implemented■   

❍   

●   



Added Play From Beginning MIDI button. This plays the score from the start,
regardless of where the active position is

■   

Updates

Music bar automatically stored at the start of every section■   

Autosave now saves the last ten files instead of just the last five■   

Music notation now uses chord names (combined with the key signature) to
determine the proper accidental to display

■   

Upgraded bends with the ability to control vertical drawing placement■   

Tempo markers updated to includes listessos and more triplet feel types■   

Redesigned how Time signatures are stored. They also now have a Pulses value
to determine how metronome clicks during playback

■   

Chord Name class upgraded. Allows for N.C. + Brackets as well as B#, Fb, E#, Cb■   

Dynamic support added for rhythm slashes■   

Anacrusis' (Incomplete bars at start of score) are now allowed■   

Changed how Let Ring was implemented during playback. In old version, was
using hold pedal data, but replaced that scheme with "let ring ties"; this holds the
note until let ring is over, or next note on same line is hit

■   

Playback completely dependant upon Gtr. Ins now. If Gtr. Ins aren't properly
placed, no music will play back

■   

Artificial Harmonics now capable of displaying double sharps/flats in pitch name■   

Artificial Harmonic pitch accidentals are now drawn using Power Tab font■   

Copyright now prints at bottom of first page of printer output■   

Muted notes and Time Signature numbers are now drawn using Power Tab font■   

Trilling and tremolo picking now use a ratio based on the current tempo to
calculate the note durations during playback. In the old version, they were just
given 32nd note values

■   

Transcriber and Performance Notes have been split into two, to allow for seperate
data on each score type (Guitar and Bass)

■   

Help buttons enabled on Property Sheets (Guitar Property Sheet, MIDI Setup
Property Sheet, Options Property Sheet, Song Property Sheet)

■   

■   

Fixes

Undo/Redo Bug - Removing an item, followed by an Undo, then a Redo would
cause a crash

■   

Bug fixed in rhythm slash analyzer/convertor■   

D.C. al Fine + Fine bug fixed■   

Triplet Feel bug -> using end of measure to calculate triplet feel now■   

Fixed triplet/irregular grouping drawing bug■   

Fixed suspended note drawing bug■   

Fermenta drawing implemented■   

Bug fixed for SEQUENCE_NUMBER META tag during MIDI import, caused crash on
import under the right circumstances

■   

Fixed rhythm slash rest justification bug - when justifying data in a section, it
wouldn't properly space out rhythm slash rests

■   

Fixed Chord Dictionary memory leak■   

Fixed Time Signature top # bug - time signature dialog should have allowed up to
32 as top value, but was only allowing up to 16

■   

Fixed 1/8 + 1/8 + 1/4 dotted + 1/8 beaming bug■   

■   



Fixed 8th + 32nd triplet beaming bug■   

Fixed 1/16 + 1/64 + 1/64 rest + 1/8 beaming bug■   

Fixed 1/16th triplet + 32nd rest + acc + 16th dot beaming bug■   

Fixed Tuning Dictionary + Score Checker header control bug (not using GetItem
properly) - this would cause the Tuning Dictionary to crash upon load

■   

Export To MIDI error fixed. During export to MIDI, a text file is written to the
desktop or the program crashes. This was a debug technique that has been
removed

■   

Export MIDI - Fixed: wasn't exporting expression or holdpedal data■   

Export MIDI - Pause at start of song removed (shut off count in)■   

Export MIDI - Wasn't exporting the proper pitch wheel range so bending and
sliding didn't sound right

■   

Export ASCII/HTML - Numerous errors fixed; completely redesigned■   

Playback bug with Gtr. Ins - Aerosmith Toys in Attic/Santana Black Magic■   

Playback bug with bends, if played normal note, then bent on tied. Had to shift
note to sibling

■   

Playback bug with tempo, tempo wasn't changing on jumps■   

Playback bug: Trilling/TP was processing normally after it was finished, and
ended up adding the extra note (as if played normally)

■   

Playback bug: Tremolo picking + slides/bends wasn't working, fixed it■   

Playback bug: Tremolo picking + tied note wasn't working, needed to pass line no
to process function, the last tp note was being removed from queue because it
defaulted to line 0

■   

Playback bug: Bends over duration of more than one note wasn't working, was
bending over first note only

■   

Playback bug: Legato sliding fixed up■   

Version 1.0.2 - Feb. 21, 2000

Full descriptions of the bugs fixed in this version can be found in the Knowledge Base Article
Q000004: "FIX: Description of Bugs Fixed In Power Tab Editor 1.0.2"

Help Menu enabled■   

Web Links on Help Menu working■   

Bend and Tremolo Bar pitch values now use actual numbers during display instead of the
ASCII characters for 1/4, 1/2, 3/4

■   

Added hot key for toggling note duration (shift + up/down arrow)■   

Added hot key for toggling note dots (shift + left/right arrow)■   

Added hot key for toggling staccato (z)■   

Hot key for "a" listed on menu as acciaccatura, but was changed to accent■   

Added undo capabilities to Shift Forward/Backward, Shift Tab Number Up/Down and
Justify

■   

Tremolo Bars max pitch change set to 7 steps now■   

Fixed acciaccatura beaming bug■   

Fixed bug where chord name replaced on single note slashes when updating a chord
name in the chord diagram list

■   

Fixed bug where new chord diagram changed all "C" chord names within the score■   

Fixed acciaccatura shifter tool bug■   

Fixed time signature common/cut time bug■   

❍   

http://www.crosswinds.net/members/~powertab/q000004.html


Fixed bug when removing a rest that's part of an irregular grouping■   

Fixed bug when attaching staff in middle when there's a Gtr. In on top■   

Fixed the save modified bug■   

Version 1.0 (Beta Release 1) - Feb. 6, 2000

Standard Music Notation■   

Most of the common tablature and music notation symbols■   

MIDI Playback■   

Multiple Staves■   

Rhythm Slashes■   

Score Preview and High Quality Printout■   

The Chord Dictionary■   

The Tuning Dictionary■   

Import MIDI Tracks■   

Exportation to MIDI, Text and HTML■   

❍   
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Quick Steps to Creating a New Score
Select the New menu item from the File menu. Choose the appropriate tablature staff types for both
the Guitar and Bass Score. Click the OK button. 

1.  

Select the Song Attributes menu item from the View menu. Enter all pertinent information about the
song. Click the OK button. 

2.  

Select the Setup menu item from the Guitar menu. Add all the guitars you will need in the score by
using the Add Guitar button on the top right corner of the screen (note that the guitars listed are for
the active score only). You can have up to 7 guitars combined total in BOTH scores. ie. 6 guitars + 1
bass guitar, 5 guitars + 2 bass gtrs. 

3.  

With the Guitar Property Sheet still open, click the Chord Diagram List tab. Add any chord
diagrams that will be used in the score. Click the OK button. 

4.  

If you're scoring out a Bass Guitar part, select the Bass Score menu item from the View menu. 5.  

Set the key signature of the song by selecting the Key Signature menu item on the Music Symbols
menu. 

6.  

Set the time signature of the score by selecting the Time Signature menu item on the Music
Symbols menu. 

7.  

Start tabbing out the song.8.  

© 2000 Brad Larsen. All rights reserved. Terms of use.
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Toolbars
There are 10 toolbars in Power Tab, and it's a good idea to hide the ones you don't use often to allow for
more "elbow space" while you're composing songs. To view the current toolbar status select the Toolbars
menu item from the View menu. The Toolbar Dialog Box appears:

The Toolbar Dialog Box

To hide/show a toolbar, simply click on the check box next to the name of the toolbar you wish to hide/show.
All of the toolbars are dockable, meaning that you can attach them to the top, left or bottom of the screen.
(you can't attach them to the right hand side due to the document scroll bar)
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Creating a New Power Tab File
To create a new Power Tab File, select the New menu item from the File menu. The New Power Tab File
dialog box will appear:

The New Power Tab File dialog box

Since a Power Tab File is made up of two separate scores (see The Score Layout), you must select the
tablature setup for both the Guitar and Bass score. To do so, simply select the appropriate tablature staff
string type from the list(s) using the mouse. The Default Button can be used to save the current tablature
staff setup (for both scores) as the default settings. The settings that are currently selected will then be used
each time a new file is created. For example, if you are a five string bass player, you'll probably want to set
the Bass Score tablature default to five. To do so, set the Bass Score tablature staff type to five strings, then
click the Default Button. The next time you create a new file, the Bass Score setting should initialize to five.

© 2000 Brad Larsen. All rights reserved. Terms of use.



The Score Layout
Power Tab was designed based on the layout commonly seen in popular guitar magazines and songbooks.
Instead of having one complete score where all the instrument parts are transcribed on one sheet, each song
is split into three primary parts:

The Guitar Score - This is where all the guitar parts should be transcribed, as well as any instruments
that are arranged for guitar (say an organ, sitar or piano part) 

●   

The Bass Score - This is where all the bass guitar parts should be transcribed ●   

The Drum Score - This is where all drum and percussion parts should be transcribed (The Drum Score
is not implemented as this time)

●   

To switch between scores, select the appropriate score menu item from the View menu.

It is important to understand that each score is completely separate from the other and that there is no
common data shared between them. All tempo markers, time signatures, etc. are indigenious to the score
that they are stored in. What this means is that you can transcribe a Bass Score in a completely different
meter than the Guitar Score. You do not, in any way, have to follow the meter/measure/musical flow patterns
in the other score.

At this point, you may be wondering how playback works when you can use completely unique scores within
the same song.  It's simple. During playback, all of the music note data from each score is combined to create
the full song. The tempo speed/changes/metronome clicks are all determined by the musical
symbol data stored in the score that's active when the play button is clicked. As an example, let's
assume the following contents exist in a Power Tab file:

Contents of Guitar Score Contents of Bass Score

Whether or not you click the play button in the Guitar Score or in the Bass Score, all of the music notes (8 e
notes on the guitar, 8 a notes on the bass guitar) are played. However, if you clicked the play button while
the Bass Score was active, the playback of the song will sound slightly slower, due to the fact the Bass Score
is set to have a tempo of 152 beats per minute, as opposed to the Guitar Score which is played at 165 beats
per minute. In similar fashion, the metronome clicks and their strong/weak accents are determined by the
time signature of the active score during playback.

© 2000 Brad Larsen. All rights reserved. Terms of use.



Navigation
Most of the navigation methods can be found on the Position menu under the Section and Staff menu
items. The following is a list of shortcut keys that you can use for quick navigation:

Section Navigation

Move To First Section - Ctrl + Home❍   

Move To Previous Section - Page Up❍   

Move To Next Section - Page Down❍   

Move To Last Section - Ctrl + End ❍   

●   

Position Navigation (within a staff)

Move To First Position - Home❍   

Move To Previous Position - Left Arrow❍   

Move To Next Position - Right Arrow❍   

Move To Last Position - End ❍   

●   

Other Navigation

Move to Previous Line - Up Arrow❍   

Move to Next Line - Down Arrow❍   

Move to Previous Measure - Shift + Tab❍   

Move to Next Measure - Tab❍   

●   

You can also navigate through the score by using the Go To menu items on the Edit menu.
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The Status Bar
The status bar is located at the bottom of the editor. It displays the following information to the user:

Power Tab Editor Status Bar

Current Time Signature 1.  

Rhythm Slash Measure Status - Amount that the current measure's rhythm slash total is off by.
Displays "OK" when the total matches the expected total 

2.  

Measure Status - Amount that the current measure's normal or high melody total is off by. Displays
"OK" when the total matches the expected total 

3.  

Low Melody Measure Status - Amount that the current measure's low melody total is off by.
Displays "OK" when the total matches the expected total 

4.  

Current Line Height - Separation between tab staff lines 5.  

Current Position Width - Separation between positions in the current section 6.  

Autosave Indicator - Displays "SAVE" when the autosave feature is saving a file 7.  

Current Position - Current position within the score. Sec = Section #, Sta = Staff within Section, Pos
= Position within staff, Ln = Line Number on tablature staff

8.  

© 2000 Brad Larsen. All rights reserved. Terms of use.



What is a Section?
A section is a portion of the score from time A to time B. Sections do not wraparound the screen, as each one fits across the page. Each section will
contain at least one staff, and may have as many as three staves. Each section may also have rhythm slashes (only one set, at the top of the section).
During screen display, each section is surrounded by a solid gray line. These lines do not show up during print out.

Note: Don't confuse a Power Tab defined section with the section that's defined in music theory. The music theory section is essentially a passage
between two double bars.

Section consisting of two staves

The above diagram shows a section consisting of 2 staves. Guitar one is playing the notes on the top staff, and guitar two is playing the notes on the
bottom staff.

Every new Power Tab file starts off with an empty section at the start of each score. You cannot remove this section.

© 2000 Brad Larsen. All rights reserved. Terms of use.



Adding A New Section
To add a new section to the active score, select the New Section menu item from the Staff menu. When
you add a new section to the score using this method, the section is placed at the end of the score. If
you need to add a new section to somewhere else in the score, use the Inserting a New Section method.
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Attaching a Staff to a Section
Well, you've just added a section, but in the song you're transcribing, there's more than one guitar part
playing at the same time in the song. What you need to do is to attach a staff to the section. Select the
Attach Staff menu item from the Section menu. At this point the Attach Staff dialog box will open:

The Attach Staff Dialog Box

All that is necessary to do is to first select the type of staff (# of strings) to add, and then determine where to
place the staff within the section. For the type of staff, simply select the appropriate number that matches the
number of strings on the guitar. For section placement, there are only three possible positions (since this
version of Power Tab only allows three staves per section): Top, Middle and Bottom, which are all
self-explanitory.
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Changing The Number Of Tablature Lines
On A Staff
To change the number of tablature lines on a staff, you must click on the "TAB" lettering on the far left side of
the tablature staff that you wish to change. The Tablature Staff Type Dialog Box will appear:

The Tablature Staff Type Dialog Box

Note: If you have data on the tablature staff, and are changing from a higher tablature staff type to a lower
tablature staff type (say from 6 to 4), the data on the lines that are outside the range of the new tablature
staff type will be deleted.
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Inserting a New Section
Inserting a new section is similar to adding a new section, except for one thing: Insertion will place the
section before or after the current section, whereas adding a section will always place the new section at the
end of the score. To insert a new section before the current section, select the Insert Before menu item on
the Section menu. To insert a new section after the current section, select the Insert After menu item on
the Section menu.
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Removing a Section or Staff
To remove the current section or staff from the score select the Remove Section menu item on the Section
menu. If there is only one staff in the section, you will be asked to verify that you wish to remove the section
(since every section must have at least one staff). If there is more than one staff in the section, the Remove
Staff dialog box will appear:

The Remove Staff dialog box

Remove Current Staff Only - Removes the current staff from the section, keeping the rest of the
staves in the section intact 

●   

Remove Entire Section - Removes all staves in the section●   
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Position Width and Line Height
Position Width - This is the horizontal separation between note positions (tab numbers) on the staff.
The Position Width can be changed by selecting the Position Width menu item on the Section menu.
Only the position width of the current section is affected. You can automatically justify all the positions
(based on the note durations) in a section by selecting the Justify menu item on the Section menu. 

●   

Line Height - This is the vertical separation between tablature staff lines. The Line Height can be
changed by selected the Line Height menu item on the Section menu. Changing the Line Height
affects all tablature staves in the both scores.

●   
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Fills
Fills will be implemented at a future time

See Also: Topic, Topic2

© 2000 Brad Larsen. All rights reserved. Terms of use.
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File Information
To edit the File Information select the File Information on the View menu. The File Information
Property Page will appear.  If the file you are working on is a song, then select the Song File Classification
type.  The following controls will appear:

The Song Attributes Property Page - Song File Classification

Title - Title of the song●   

Artist - Artist who performed this version of the song●   



Release Type - How the song was released

Public Release (Audio) - Song was released to the public in audio form (ie. cd, tape, vinyl)

Album Title - Title of the album the song was released on■   

Album Type - The type of album the song was released on (double album, boxset, single
album, etc.)

■   

Live Recording - Is the song a live recording?■   

Year - The year the album was released■   

❍   

Public Release (Video) - Song was released to the public in video form (ie. concert tape)

Video Title - Title of the video the song was released on■   

Live Recording - Is the song a live recording?■   

❍   

Bootleg - Song is from a bootleg

Bootleg Title - The name of the bootleg (usually a venue)■   

Bootleg Date - The date of the bootleg recording■   

❍   

Not Released - Song has never been released (usually a personal song)❍   

●   

Music By - Person(s) who wrote the music to the song●   

Words By - Person(s) who wrote the lyrics to the song●   

Traditional - The song's author is unknown (ie. Greensleeves)●   

Arranged By - Person(s) who arranged this version of the song (if the song is a re-make)●   

Gtr. Score Transcribed By - Person(s) who transcribed the guitar score of the song●   

Bass Score Transcribed By - Person(s) who transcribed the bass score of the song●   

Drum Score Transcribed By - Person(s) who transcribed the drum score of the song●   

Copyright - Copyright Notice●   



The Song Attributes Property Page - Lesson File Classification

Title - The title of the lesson (usually a creative title)●   

SubTitle - Description of the lesson●   

Style - The type of music style that the lesson encompasses (choose General if it encompasses all
styles)

●   

Level - The difficulty level of the lesson●   

Author - The author of the lesson●   

Copyright - Copyright Notice●   
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Performance Notes
Performance Notes are notes that give an overview or instructions about the song performance. They are
split into two parts, one for the Guitar Score and one for the Bass Score. To edit the performance notes of the
song, select the Performance Notes menu item on the View menu. The Performance Notes Property
Page will appear:

The Performance Notes Property Page

Note: In order for the Performance Notes to be sent to the printer you must have the Print Performance
Notes item checked under the Printing Options. Only the performance notes for the score being printed are
sent to the printer.
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Lyrics
Lyrics will be implemented in a future release

See Also: Topic, Topic2
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Fonts
To set the Fonts to be used within the song, select the Fonts menu item on the View menu. The Font
Property Page appears:

The Font Property Page

To change a font, click the Change Font Button and select a new font. You can save the current font as the
default font by clicking the Default Button.

At present time there are two fonts you can change:

Chord Name Font - This is the font used by chord name text 1.  

Tablature Font - This is the font used by the tablature numbers on the tablature staff2.  
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Guitar Setup
The Guitar Setup Property Page is used to define the guitars that are used in a song. Up to 7 guitars can
be used in one song, each with their own tuning and effects. To edit the guitar setup on the active score,
select the Setup menu item on the Guitar menu. The Guitar Property Sheet will appear:

The Guitar Property Sheet

When you open the Guitar Setup Property Page, only the guitars in the active score appear. (ie. - If you had
the Guitar Score active when you opened the Guitar Setup Property Page, only the guitars used in the Guitar
Score are listed, if the Bass Score was active, only the guitars used in the Bass Score are listed). By default,
there will be one guitar per score for each new song created. You must have at least one guitar for each
score, and if an attempt is made to remove it, it will fail. To view the setup of a guitar in the list, click on the
appropropriate tab from the Guitar Tab Selectors.



Adding A New Guitar

To add a new guitar to be used in the active score, click the Add Guitar Button. A new tab will be added and
activated on the screen. Enter the appropriate information for the guitar:

Desc. - This is simply a description of the guitar. Usually, it will be the type of instrument, with the
effects applied to it in brackets. (ie. Acoustic Gtr. (w/Leslie), Elec. Gtr. (w/dist), etc.)  

●   

Strings - This is the number of strings on the guitar. You can select from 3 to 7 strings.  ●   

MIDI - This is the MIDI patch (Instrument) that is used by the guitar. This will be the guitar sound
that is heard when the guitar plays some/all of the tablature during playback. For an acoustic guitar
sound, try the Steel Guitar or Classical Guitar patch. For electric guitars there are patches for both
clean and distorted sounds. There are also patches for banjos, sitars and dulcimers. 

●   

Capo - This simply acts as a pitch shifter. A capo is a device that clamps down on the guitar neck at a
particular fret, thus making the open strings sound higher in pitch. When notating guitar parts for a
guitar that uses a capo, type in the fret numbers relative to the capo, not the open position. (ie. If you
have a capo on the 5th fret and you want to notate a note on the 7th fret, use the number 2, not 7).
The capo can be placed anywhere from the 1st fret up to the 12th fret. A capo value of 0 signifies that
the guitar does not use a capo.  

●   

Initial Vol. - This is the initial volume level on the guitar ●   

Tuning - On the right side of the screen is a vertical listing of each tuning note for each of the guitar
strings on the guitar. Simply use the spin button to change the tuning for a string. The number beside
each note (ie. The 4 in E4) signifies the octave that the note belongs to. The value C4 is Middle C. You
can use that as a reference to other tuning notes. The tuning notes are listed vertically from high
to low. To the right of each tuning note/spin button is a tuning button, which, when clicked, will play
the note. You can use this feature to tune your guitar.

You can load a pre-defined tuning by clicking on the Tuning Dictionary Button, and then selecting a
tuning. You can also save the current tuning as the default (it will be used each time a new guitar is
created) by clicking on the Default Tuning Button. Tunings may either use sharps or flats (not both).
You can toggle between sharps and flats by clicking the Toggle Sharps Button. 

●   

Off. - This is the musical note offset (in half steps) that will be used when transcribing the score.
Suppose you were transcribing a song that uses the tuning Eb Ab Db Gb Bb Eb (1/2 step down) and
plays the chord progression Eb Ab Db. Instead of notating the score using this weird key, you can set
the musical note offset to 1, which will draw all the music notes in the score 1/2 step higher than they
actually sound. In this case you could use E A D instead, which is much easier to read. The musical
note offset has no bearing on the song's playback pitch, it is a cosmetic item only. 

●   

Pan - This is simply the stereo "position" of the guitar in the song's mix. The further the slider's
pointer is moved to the left, the further left in the mix the guitar will be. Likewise for moving right. 

●   

Effects - There are a small number of effects that can be applied to each guitar. Reverb provides an
echo effect, chorus provides a doubling effect and tremolo provides a vibrato effect. Each effect is
controlled by a slider control. The closer the slider's pointer is moved to the top, the more prominant
the effect will be. You cannot change the effects on a guitar within a song (ie. A guitar can't start out
clean, then 30 seconds later have reverb and distortion) To achieve this, you'd have to use 2 separate
guitars (one clean, one with effects) and notate to the reader's of the tab that is in fact one guitar, but
you are using 2.

●   

Removing A Guitar

To remove a guitar, simply select the appropriate guitar from the Guitar Tab Selector and click the Remove
Guitar Button. All Gtr In symbols for that guitar will be removed from the score

Once you've defined all your guitars that are needed for the song, you can select where the guitars are
"applied" within the song by using Guitar In Symbols .
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Guitar Ins
Guitar Ins are symbols used to notate which guitar/guitars are playing the current notes on the staff. To insert a guitar in
symbol at the current position, select the Guitar In menu item on the Guitar menu. The Guitar In dialog box will appear:

The Guitar In dialog box

Simply select the guitars that you wish to activate by clicking the checkbox for the corresponding guitar(s). To activate rhythm
slash Gtr Ins, there must be at least one rhythm slash or rhythm slash rest in the section, and you must open the Gtr In dialog
box while the position indicator is somewhere on the first staff in the section.

How It Works

Each Gtr In symbol effectively cancels out the previous Gtr In for that staff. In this sense it works similar to key signatures. The
following diagram illustrates using Gtr Ins:

Guitar In Example

In the above example, guitar 1 plays the first measure solo. In measure 2, guitar 2 joins with guitar 1 (note that you must
include both Gtr I and II here). Guitar 2 then goes solo in measure 3, with the final measure combining both guitars again like
in measure 2. This leads to "compressed" scores which don't require a separate staff for each guitar playing the same data. You
do not need to insert Gtr Ins on each section in the score. The last guitar(s) that were used on the previous section's staff will
be "carried over" and used on the matching staff in the section that follows. If there were a section inserted after the section in
the above diagram, both guitar I and II would be active at the start of the new staff, because they were the guitars active at the
end of the previous section.

See Also: Guitar Setup
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Alteration Of Pace
Alteration Of Pace symbols are used to gradually change the speed of the tempo in the song over a duration of time. There are two
types of alterations: accelerando (increase in pace) and ritardando (decrease in pace). To insert an Alteration Of Pace symbol at the
current position, select the Alteration Of Pace menu item from the Music Symbols menu. The Alteration Of Pace Dialog Box will
appear:

The Alteration Of Pace Dialog Box

How It Works

The alteration symbol takes the tempo that is active where the alteration symbol exists, and scans ahead for another tempo marker.
If a tempo marker is found, the difference between the tempos is calculated and used for the alteration amount. If no tempo marker
is found, the tempo will be altered using twice/half the active tempo from the current position to the end of the score. It is left to the
user to ensure that the proper symbol (accel. or rit.) is notated correctly when an alteration symbol is placed between two tempo
markers.

Example 1

Alteration Example 1

In the above example (ex. 1), measure 1 is played entirely at 80BPM. At the start of the 2nd measure, there is an alteration of pace
symbol (accelerando). Since there is a tempo marker at the start of measure 4 (120BPM), the alteration difference is calculated as:
120 - 80 = 40BPM. Therefore a gradual increase of 40BPM will occur from the start of measure 2, to the start of measure 4.

Example 2

Alteration Example 2



Dynamics
Dynamic symbols are used to notate the volume level of a guitar/instrument. The volume levels are
represented by using shortform/initials for their italian music term counterparts. The symbols and their terms
are listed below, from highest volume level to lowest.

Dynamic Symbol Italian Term Volume Level Description
fff ? Loudest
ff Fortissimo Very Loud
f Forte Loud

mf Messo-forte Moderately Loud
mp Messo-piano Loud, then Soft immediately
p Piano Soft
pp Pianissimo Very Soft
ppp ? Softest
off None No Sound

The initial volume level of a guitar is determined by the Initial Volume setting on the Guitar Setup Property
Page. To insert a dynamic symbol at a position in the score, select the Dynamic menu item from the Music
Symbols menu. The Dynamic Dialog Box will appear:

The Dynamic Dialog Box

There are two volume levels that can be set: rhythm slash and staff. The rhythm slash volume list controls
the volume level for all guitars that are currently playing the rhythm slashes. (The rhythm slash volume list
will be disabled if there are no rhythm slashes in the current section). The staff volume list controls the
volume level for all guitars that are currently playing on the active staff. If you have both lists active, but only
wish to use a volume level for one, select the "X" list item from the list that you don't want to update the
volume for.
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In the above example (ex. 2), measure 1 is played entirely at 80 BPM. At the start of the 2nd measure, there is an alteration of pace
symbol (accelerando). Since the end of the score is reached before another tempo marker is found, the alteration difference is
calculated as: 2 * 80 - 80 = 80 BPM. Therefore a gradual increase of 80BPM will occur from the start of measure 2, to the end of the
score (end of measure 4).
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Key Signatures
To avoid writing many accidentals, the necessary sharps and flats are grouped, and written at the beginning
of the staves, following the clef sign. This group is known as a key signature, and governs certain notes
throughout the music, which is said to be in a definite key, named after the scale that is in use. There are 2
primary types of scales that define key signatures, Major and Minor.

Key Signatures may only be inserted at two places within the score:

The first position of a section; this will set the key signature at the start of the section 1.  

The same position as a music bar; It is suggested that you use a double bar when using a key
signature at the same position as a music bar. Doing so eleviates from cancellation keys.

2.  

To insert a key signature, select the Key Signature menu item from the Music Symbols menu. The Key
Signature dialog box appear:

The Key Signature dialog box

Select the appropriate key signature from the list and click the OK button. The new key signature will appear
in the score. The signature will automatically update all other sections up to the next key signature that
doesn't match the one you added or replaced, or until the end of the score.

Note

The key signature is the same for all staves in the section, you cannot set a different key signature at the
same position on different staves.
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Music Bars
Music bars (bar-lines) are used to divide the music into measures. Music bars can be placed anywhere in the section where there is no other music
data (you can't insert bars overtop of notes). Music bars have a section scope. That is, if you add a music bar to one staff in a section, they are
drawn for all staves in the section. If you remove a music bar from a staff, it removes it from all staves in the section (at that particular position). To
insert a music bar at the current position, select the Music Bar menu item from the Music Symbols menu.

** Important Update For Version 1.5 **

Note: At the start of every section there is now a "hidden" music bar. You should notice that the music bar toolbar button is depressed when you
move the position indicator to the first position in a section. This is signalling to the user that a bar already exists at the position. When this "starting
bar" is set to a normal bar type, nothing will be displayed. If you wish to "add" a repeat start bar to the start of the section, it is now achieved by
editing this starting music bar. Simply click on the music bar toolbar button to do this. Once the starting bar is set, it will automatically shift the
starting position to the right, just as it would for a time or key signature

Note: To change the music bar at the end of a section, move the mouse cursor over the right margin of the section. You should see the cursor

change to . When the cursor changes, click the left mouse button). The Music Bar dialog box will appear:

The Music Bar dialog box

Simply click on the appropriate music bar from the list, and then click OK. The music bar will be inserted at the current position in the score.

There are six types of music bars that can be selected, each shown below, with a description following:

Music Bar Types

Diagram # - Bar Type Description/Use
1 - Standard Bar Used in most cases to separate measures
2 - Double Bar (Break) Used to represent the start of a new part/passage of

a score (such as a verse, chorus, bridge). It is also
used when a key signature change occurs somewhere
other than the start of a new section.

3 - Free Time Bar Used in place of standard bar when music tempo is
notated as "Free Time"

4 - Repeat Start Bar/Leave Open Used to mark the start of a music passage that
is to be repeated. You must have a Repeat End
bar for every Repeat Start bar.

●   

A Repeat Start bar cannot be placed at the end
of a section. In it's place, a Leave Open bar
type is used. This will draw no bar at all. This
is commonly used when a key or time
signature change occurs at the end of a
section:

●   

End of section with bar left open due to
key and time signature change



5 - Repeat End Bar Used to mark the end of a music passage that is to be
repeated. By default, a passage is to be played twice.
If there is a number above the Repeat End bar in the
format "nx", then you are to play the passage that n
times. ie. If there is a 4x, this equates to "Play 4
times".

6 - Double Bar (Ending) Used to notate the end of the score. Should be placed
at end of last section in score only.
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Musical Directions
In order to save time and space, special Music Direction symbols are used to notate jumps to marked
passages in the song. To insert a Music Direction at the current position, select the Musical Direction menu
item from the Music Symbols menu. The Musical Direction dialog box will appear:

The Musical Direction dialog box

Up to three direction symbols may be placed at the same position. The directions are executed in order from
left to right (or top to bottom in the score).

Adding A Direction

To add a direction to the list, simply click on the Add Direction Button.

Removing A Direction

To remove a direction to the list, simply click on the Remove Direction Button while the direction you want
to remove is active



Trigger Conditions

These are conditions that must be true in order for the current direction's jump to occur.

Active Symbol: The direction that must be active (the jump for the direction has occured) in order for
the current direction jump to occur. This will apply primarily to directions like "To Coda". 

●   

Repeat #: The repeat count number that must be matched in order for the current direction jump to
occur. (ie. you may have a "To Coda" symbol inside a repeat passage and you want it to jump on the
3rd repeat) Leave this value at 0 if no repeat # needs to be active for the jump to occur.

●   

The following table describes each of the 19 musical directions:

Direction Symbol Description/Use
Coda Used to mark the start of a new music passage

Double Coda Same as above
Segno Used to mark the start of a music passage to be repeated

Segno Segno Same as above
Fine Used to mark when to stop playing (usually the end of the score)

Da Capo Go back to the beginning of the score and play from there
Dal Segno Go back to the Segno and play from there

Dal Segno Segno Go back to the Segno Segno and play from there

To Coda Go to the Coda sign and play from there.  Used in conjunction with
D.C./D.S. al Coda signs.

To Double Coda Go to the Double Coda and play from there.  Used in conjunction
with D.C./D.S. al Double Coda signs.

Da Capo al Coda Go back to the beginning of the score and play from there until the
To Coda sign is reached, then jump to the Coda sign.

Da Capo al Double Coda
Go back to the beginning of the score and play from there until the
To Double Coda sign is reached, then jump to the Double Coda
sign.

Dal Segno al Coda Go back to the Segno sign and play from there until the To Coda
sign is reached, then jump to the Coda sign.

Dal Segno al Double Coda Go back to the Segno sign and play from there until the To Double
Coda sign is reached, then jump to the Double Coda sign.

Dal Segno Segno al Coda Go back to the Segno Segno sign and play from there until the To
Coda sign is reached, then jump to the Coda sign.

Dal Segno Segno al Double Coda Go back to the Segno Segno sign and play from there until the To
Double Coda sign is reached, then jump to the Double Coda sign.

Da Capo al Fine Go back to the beginning and play until the Fine sign is reached.
Dal Segno al Fine Go back to the Segno sign and play until the Fine sign is reached.

Dal Segno Segno al Fine Go back to the Segno Segno sign and play until the Fine sign is
reached.
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Rehearsal Signs
Rehearsal Signs are used to mark passages (parts/sections of the score) for rehearsal. The length of the
passage is determined by the next rehearsal sign in the score. For example, if you have a rehearsal sign at
the start of the first measure in the score called "Intro" and the next rehearsal sign is at the start of measure
twelve in the score, the "Intro" passage would run from the start of measure one, to the end of measure
eleven. If there is no rehearsal sign after the current rehearsal sign, then the rehearsal passage runs to the
end of the score.

Rehearsal Signs may only be inserted at two places within the score:

The first position of a section. 1.  

The same position as a music bar.2.  

To insert a rehearsal sign at the current position, select the Rehearsal Sign menu item from the Music
Symbols menu. The Rehearsal Sign dialog box appears:

The Rehearsal Sign dialog box

Simply select a letter from the list of available letters (rehearsal passages are normally listed alphabetically in
the score).  Each letter may only be used once in a score.  Once you've selected a letter, enter a description
that describes the passage.  Intro, Verse, Chorus, Bridge, Interlude, Outro are common descriptions used for
rehearsal passages.
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Repeat Endings
Repeat Endings are markers used to notate different endings in a repeated passage. Follow the appropriate
ending based on the repeat count number. To insert a repeat ending at the current position, select the
Repeat Ending menu item from the Music Symbols menu. The Repeat Ending dialog box will appear:

The Repeat Ending Dialog Box
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Song Fade In/Out
To set the song's fade in/out values, select the Fade menu item from the Music Symbols menu. The Fade
Dialog Box will appear:

The Fade Dialog Box

Working With MIDI Units

Power Tab uses MIDI units to represent the amount of time that the song will fade in/out. A value
of 720 MIDI units is given to the duration of a single quarter note. From this value, it is possible to
calculate the MIDI units for other note durations:

1 Whole Note = 4 quarter notes = 4 * 720 = 2880 MIDI units
1 Half Note = 2 quarter notes = 2 * 720 = 1440 MIDI units
1 8th Note = 1/2 quarter note = 720 / 2 = 360 MIDI units
1 16th Note = 1/4 quarter note = 720 / 4 = 180 MIDI units
etc.

Knowing the above, it is then possible to calculate the song's fade in/out times in MIDI units:

Ex. 1 - A song is in 4/4 time, we want the fade in to occur over the first 5 measures of the
song

We know there are 4 quarter beats in one measure in 4/4 time, and that one quarter note is 720 MIDI
units. Therefore, one measure of 4/4 time = 4 * 720 = 2880 MIDI units. We want to fade for five
measures and one measure is 2880 units, so the proper fade in time is 5 * 2880 = 14400 MIDI units. 

●   

Ex. 2 - A song ends with alternating 6/8 + 5/8 measures, we want the fade out to occur
over the last 8 measures of the song

In the last 8 measures of the song, we have four 6/8 measures, and four 5/8 measures. We know that
an 8th note is 720 / 2 = 360 MIDI units. Therefore, each 6/8 measure totals 6 * 360 = 2160 MIDI
units, and each 5/8 measure totals 5 * 360 = 1800 MIDI units. The fade out total is then calculated as

●   



4 * 2160 (four 6/8 measures) + 4 * 1800 (four 5/8 measures) = 15840 MIDI units.

Note: Power Tab does not insert a "fade" symbol for song fade in/outs. It is left to the user to notify the
reader of the score when and where the fade(s) occur. Most scores use the bold text Fade In and Fade Out
at the point where the song is faded. Instructions on how to insert text into the score can be found here.
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Tempo Markers
Tempo Markers (aka M.M. - Maelzel's Metronome) are used to measure the exact time (speed) of the beat. The tempo is
measured in beats (or pulses) per minute, and is usually represented as the number of quarter note beats per minute. To
insert a Tempo Marker at the current position, select the Tempo Marker menu item from the Music Symbols menu.
The Tempo Marker dialog box will appear:

The Tempo Marker dialog box

The Beat Type

This is the type of note that is used to represent one beat. It is dependent upon the time signature of the song. The
following is a list of popular time signatures and which beat type should be used with each:

Time Signature Beat Type
4/4 Quarter Note
2/2 Half Note
3/4 Quarter Note
12/8 Quarter Dotted Note
6/8 Quarter Dotted Note

When you are inserting a new tempo marker into the song, the proper beat type will automatically be selected when the
dialog box is opened (based on the current time signature). If the proper beat type is not chosen, the tempo may sound
too slow or too fast. The formula for determining the beat type (basic beat) of a given time signature is:

A) if the top number in the time signature is divisible by 3, BUT NOT THE NUMBER 3:
3 / lower number in the time signature

i) 12/8 => beat type is 3/8 or quarter dotted
ii) 9/4 => beat type is 3/4 or half dotted
iii) 6/16 => beat type is 3/16 or eighth dotted

B) if the top number in the time signature is not divisible by 3, OR IS THE NUMBER 3:
1 / lower number in the time signature

i) 2/2 => beat type is 1/2
ii) 3/4 => beat type is 1/4
iii) 3/8 => beat type is 1/8



Selecting The Tempo Type

There are three types of tempo markers that you can choose from:

Beats Per Minute  - This is the most common type of tempo marker. The BPM value informs the reader of
the score how many beat notes are to be played in one minute. To select this type of tempo marker, select the
proper beat type from the Beat list, then click the Beats Per Minute Radio Button. Once selected, enter a BPM
value in the edit box beside the BPM radio button. (valid range is 40 to 300) 

●   

Listesso  - When a translation in time is within a music arrangement you must define how the tempo will be
affected by the change. You can do this with a listesso marker. To select this type of tempo marker, select the
proper beat type from the Beat list, then click the Listesso Radio Button. Once selected, enter a beat type from
the Listesso list. 

●   

Do Not Show Metronome Marker - In the case that the metronome marker is not needed (ie. to notate a triplet
feel change), select the Do Not Show Metronome Marker Radio Button 

●   

Triplet Feels

Certain songs are played to what's called a Triplet (or swing/shuffle) Feel. This means that when a pair of 8th/16th notes
are to be played, the 1st note has a slightly longer duration than normal and the 2nd note has a slightly shorter duration
than normal. Usually the ratio is roughly 66% to 33% as opposed to the normal 50-50. For the most part, it's easier to
write these songs using normal 8ths/16ths and notating at the start of the song that they are to be played with a triplet
feel, than to construct the song using the actual note durations. You do not need to show a metronome marker when
using a triplet feel symbol.

Note - Triplet feel markers work on a per measure basis. That is, if you insert a triplet feel marker in the middle of a
measure, the entire measure will be played will a triplet feel effect.
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Time Signatures
Time Signatures are used to notate the number of beats (pulses) in each measure in the song. It is written in the form of a fraction, and is usually
preceeded by a Key Signature. The upper figure of the time signature indicates the number of beats in a measure. The lower figure represents the value of
each beat. For example, a time signature of 7/4 means that there are 7 beats in each measure, and that each beat receives a 1/4 note amount of time.

** Important - New For Version 1.5 **

In version 1.0.2 and lower of Power Tab, time signatures were inserted where ever the user deemed necessary, and all measures up to the next time
signature used it's data (for beaming and metronome purposes). In version 1.5 (and up), time signatures now exist at the first position of a section, and at
the same position as a music bar (ie. When you add a new section, it automatically contains a time signature at the start, which can be accessed by
moving to the first position in the section and clicking on the time signature toolbar button; likewise, when you insert a music bar, it automatically comes
with a time signature, and can be edited the same way as above). When you move to one of these positions, you will notice that the time signature toolbar
button will become depressed. When you click this button, it will open the Time Signature Dialog Box where you can edit the time signature data. Since
there are now time signatures at every bar in the score, you may be thinking, won't that make things messy, having time signatures drawn at each
measure? This is where the Show Meter option comes into play. If the Show Meter value is set, the time signature (the actual numbers) will be drawn at
the position where the time signature exists, otherwise, it will remain invisible.

Note: The score uses a time signature's meter, beaming and pulse data, regardless of whether it is shown or not.

Two New Possibilities

Alterating Beaming Patterns - Suppose you had a score in 5/8 time, and wanted to alternate the beaming style between measures. In the old
version of Power Tab, this was impossible to do, but in the new version, it's a breeze:

Alternating Beaming example

There are 2 time signatures in the above example, notated in the diagram as 1 and 2.

Time Signature 1 setup:

Show Meter : Checked
Beats/Measure : 5
Value Of Beat : 8
Note Beaming Pattern : 2 + 3

Time Signature 2 setup:

Show Meter : Unchecked
Beats/Measure : 5
Value Of Beat : 8
Note Beaming Pattern : 3 + 2

●   

Hybrid Meters - Suppose you had a score that alternated between 7/8 and 5/8 time. With a little imagination, you can implement the following:

Hybrid Meter example

There are 4 time signatures in the above example, notated in the diagram as 1 through 4.

Time Signature 1 setup:

Show Meter : Checked
Beats/Measure : 7
Value Of Beat : 8
Note Beaming Pattern : 3 + 2 + 2

Time Signature 2 setup:

Show Meter : Unchecked
Beats/Measure : 5
Value Of Beat : 8
Note Beaming Pattern : 3 + 2

Time Signature 3 setup:

●   



Setup same as 1, except Show Meter is unchecked

Time Signature 4 setup:

Setup same as 2

Note: The +5 in the numerator is just simple text, hybrid meters will be implemented fully in a future version of the program.

Editing A Time Signature

To edit a Time Signature at the current position (must be 1st position in section, or the same position as a music bar), select the Time Signature menu
item from the Music Symbols menu. The Time Signature dialog box will appear:

The Time Signature Dialog Box

Show Meter - The meter of the time signature is shown in the score ●   

Beats/Measure - This is the number of beats in one measure of music. The valid range of values is from 1 to 32. ●   

Value of Beat - This is the note amount given to each beat. The valid values for the beat amount are 2, 4, 8, 16 and 32. ●   

Use Common Time - This is a special type of time, notated by a "C" in songs. It represents 4/4 time. ●   

Use Cut Time - This is a special type of time, notated by a "C" with a line through it. It represents 2/2 time. ●   

Metronome Pulses - This is the number of metronome clicks that are to be "fired" during the measure. The pulse value must divide evenly into
the the top number of the time signature. ie. assume 6/4 time, the pulse value may be 1, 2, 3 or 6.

●   

Note Beaming Pattern - This is the beaming/grouping pattern that note durations of the denominator value in the time signature will follow (if the
denominator is less than 8, the pattern represents 8th note beaming). The pattern is repeated until the end of the measure is reached.

For example, let's say we have a 15/8 time signature with 15 8th notes that we want to follow the following pattern:

2 + 3 + 2 + 3 + 2 + 3

In this case, all you need to input into the beaming pattern edit boxes is 2 and 3. After the first five notes have been beamed (2 + 3), the pattern
starts over again. When you create or edit a time signature, the default beaming pattern is automatically selected. The beaming pattern is followed
until the next time signature in the score.

●   
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Volume Swell
A Volume Swell is a volume level change that occurs during the song. In the guitar world, volume swells can
be created by quickly turning the volume knob on the guitar. There are also volume pedals available that can
perform the feat automatically. To insert a volume swell at the current position select the Volume Swell
menu item on the Music Symbols menu. The Volume Swell dialog box will appear:

The Volume Swell dialog box

Simply select a starting and ending volume for the swell. This will determine whether it's a crescendo
(increasing volume) or a decrescendo (decreasing volume). Most swells will occur over a single note/duration,
but in the instance a swell occurs over more than one note, it can be adjusted.
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Arpeggios
Arpeggios are symbols that indicate that the notes of the chord are to be played in succession (as opposed
to all at once). The arrow on the end of the arpeggio determines which way to strum the notes. An "up"
arpeggio signifies to start with the lowest string and strum towards the highest. A "down" arpeggio signifies to
start with the highest string and strum towards the lowest.

1 - Arpeggio Up (strum notes from low to high: 3 to 0)
2 - Arpeggio Down (strum notes from high to low: 2 to 0)

To insert an arpeggio at the current position, select the Arpeggio + Up/Down menu item on the Tab
Symbols menu.
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Bends
To insert a bend at the current position, select the Bend menu item from the Tab Symbols menu. The Bend dialog box
will appear:

The Bend Dialog

Bend Types

Bend Types

Bend: Strike the note and bend up by the number of steps indicated. 1.  

Bend and Release: Strike the note and bend up by the number of steps indicated, then release the bend back to
the original note. 

2.  

Bend and Hold: Strike the note and bend up by the number of steps indicated. Hold the bend until released. 3.  

Pre-Bend: Bend the note up by the number of steps indicated and then strike the note. 4.  

Pre-Bend and Release: Bend the note up by the number of steps indicated and then strike the note. Release
the note back to the original note. 

5.  



Pre-Bend and Hold: Bend the note up by the number of setps indicated. Hold the bend until released. 6.  

Release (gradual): Release the bend over the duration of the current note duration. 7.  

Release (immediate): The bend is held for the duration of the current note duration, then released
immediately. The release sound is not heard.

8.  

Note: For every bend you use that is held, there must be a corresponding release.

Note: Bend and Release and Pre-Bend and Release types can only occur over two adjacent notes. If you need to
notate a bend/pre-bend and release that occurs over more than 2 notes, use the bend and hold type combined with a
release (gradual) type. The last bend in the above diagram shows an example of this.

Bent Pitch

The bent pitch is the peak pitch level (in half steps from normal [relaxed string]) of the bend. The Bent Pitch value is
used on Bend, Bend and Release, Bend and Hold, Pre-Bend and Pre-Bend and Release type bends only.

Release Pitch

The release pitch is the pitch level (in half steps from normal [relaxed string]) of the bend at the end of the current note
duration. In most cases, the release pitch will be standard, but in some cases, you may only want to release to 1/2 pitch
(or some other pitch):

Example of bend that is not released to standard pitch

In the above example, the bend is bent to Full, then released to 1/2 (unlike most bends which would release to
standard/relaxed string), then bent back up to Full. The Release Pitch value is used on Bend and Release, Pre-Bend and
Release and Release (gradual) type bends only.

Bend Duration

This is the duration that the bend occurs over:

Default: By default, all bends (excluding pre-bends) occur over a 32nd note duration. This value was choosen as
the average time it takes a player to bend a note. 

●   

Bend over current note duration: In this setting the bend occurs evenly over the duration of the current note. ●   

Bend over current note + next n notes: In this setting the bend occurs evenly over the current note + next n
notes.

●   

Drawing Setup

This determines how the bend is drawn from a vertical point of view. There are three vertical positions that a bend can
start or end at:



Diagram illustrating the 3 vertical drawing levels for bends

Above tablature staff (high point)1.  

Above tablature staff (mid point)2.  

Tablature staff line3.  

The vertical drawing setup will really be put to use in a situation like the following:

Diagram illustrating bent note that is held, then bent again, then released

In the above example, the first bend (up to Full) is drawn from the tablature staff line, to the mid point. This then allows
for a 2nd bend to occur, which is drawn from the mid point (where the first bend ended drawing) to the high point (thus
creating a new "step"). The bend is then finally released back to standard, and is drawn from the high point (where the
2nd bend ended drawing) to the tablature staff line.
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Hammer-Ons and Pull-Offs

Hammer-Ons

Hammer-Ons involve striking the first (lower) note, then sounding the higher note with another finger by
fretting it without picking. To insert a hammer-on at the current position, select the Hammer-On/Pull-Off
menu item on the Tab Symbols menu. The first note must be less than the second note in order for a
hammer-on to be applied.

Pull-Offs

Pull-Offs involve placing both fingers on the notes to be sounded. Strike the first note and without picking,
pull the finger off to sound the second (lower) note. To insert a pull-off at the current position, select the
Hammer-On/Pull-Off menu item on the Tab Symbols menu. The second note must be less than the first
note in order for a hammer-on to be applied.
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Harmonics
There are three types of harmonics that can be used in the Power Tab Editor:

Natural Harmonic: Strike the note while the fretting hand is lightly touching the string over the fret
indicated. To insert a natural harmonic at the current position, select the Natural Harmonic menu
item on the Harmonics sub-menu on the Tab Symbols menu. 

1.  

Artificial Harmonic: The note is fretted normally and a harmonic is produced by adding the edge of
the thumb or the tip of the index finger of the right hand to the normal pick attack. High volume or
distortion will allow for a greater variety of harmonics. To insert an artificial harmonic at the current
position, select the Artificial Harmonic menu item on the Harmonics sub-menu on the Tab
Symbols menu. The Artificial Harmonic Dialog Box will appear:

The Artificial Harmonic Dialog Box

2.  

Tapped Harmonic: Tap the string at the fret indicated in parenthesis. To insert a tapped harmonic at
the current position, select the Tapped Harmonic menu item on the Harmonics sub-menu on the
Tab Symbols menu.

3.  
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Palm Mute
Palm muting involves lightly touching the string(s) near the bridge with the picking hand. To insert a Palm
Mute at the current position, select the Palm Mute menu item on the Tab Symbols menu.
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Pickstrokes
Stroke the note with the pick in the direction indicated. To insert a pickstroke at the current position, select
the Pickstroke menu item on the Tab Symbols menu.
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Slides
There are 4 primary types of slides that can be used in the Power Tab Editor:

Legato Slide - Strike the first note and then slide the same fretted-hand finger up or down to the
second note. The second note is not struck.

1.  

Shift Slide - Strike the first note and then slide the same fretted-hand finger up or down to the
second note. The second note is struck.

2.  

Slide Into - Perform a legato slide on the note, starting from a self-determined point somewhere
above or below the note

3.  

Slide Out Of - Perform a legato slide on the note, ending at a self-determined point somewhere above
or belw the note

4.  

To insert a slide at the current position, select the appropriate slide type on the Slide menu item on the Tab
Symbols menu.

See Also: MIDI Setup
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Tap
Tapping involves tapping the fret indicated using the index or middle finger of the picking hand. To insert a
tap at the current position, select the Tap menu item on the Tab Symbols menu.
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Tremolo Bar
Use the tremolo (whammy) bar to change the pitch of the note by the notated number of half-steps. To insert
a tremolo bar symbol at the current position, select the Tremolo Bar menu item on the Tab Symbols menu.
The Tremolo Bar Dialog Box appears:

The Tremolo Bar Dialog Box

Tremolo Bar Types

Dip (simple): The pitch of the note or chord is dropped by the specified number of steps then
returned to the original pitch. 

1.  

Dive and Release: The pitch of the note or chord is dropped by the specified number of steps over
the current note duration. At the end of the note duration, the bar is released immediately to the
original pitch, but is not heard. 

2.  

Dive and Hold: The pitch of the note or chord is dropped by the specified number of steps over the
current note duration. The bar is held until the next release symbol. 

3.  

Release: The pitch of the note or chord is held for the duration of the current note duration and then
released immediately to the original pitch. The release is not heard. 

4.  

Return and Release:The pitch of the note or chord is released to the displayed pitch over the current
note duration. At the end of the note duration, the bar is released immediately to the original pitch,
but is not heard. 

5.  

Return and Hold: The pitch of the note or chord is released to the displayed pitch over the current
note duration. At the end of the note duration, the pitch is held until the next release or dive symbol. 

6.  



Inverted Dip (simple): The pitch of the note or chord is raised by the specified number of steps then
returned to the original pitch. 

7.  

Note: For every dive/release you use that is held, there must be a corresponding release.

Note: Dips can only occur over a single note. If you need to notate a dip that occurs over more than 1 note,
use the dive and hold type combined with a return and release type.

Resultant Pitch

The resultant pitch is the pitch (in half steps from normal) that you wish to end up at the end of the current
pitch change.

Tremolo Bar Duration

This is the duration that the tremolo bar pitch change occurs over:

Dive over current note duration: In this setting the dive/return occurs evenly over the duration of
the current note. 

●   

Dive over current note + next n notes: In this setting the dive/return occurs evenly over the
current note + next n notes. 

●   
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Tremolo Picking
Tremolo Picking involves picking the note as rapidly and continuously as possible. To insert a tremolo
picking symbol at the current position, select the Tremolo Picking menu item on the Tab Symbols menu.
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Trill
Trilling entails the rapid alternation between two notes using successive hammer-ons and pull-offs. The trilled
note is notated in brackets to the right of the fretted note. To insert a trill at the current position, select the
Trill menu item on the Tab Symbols menu.

© 2000 Brad Larsen. All rights reserved. Terms of use.



Vibrato
Vibrato entails rapidly bending and releasing the note with the fretting hand or tremolo bar. To insert a
vibrato symbol at the current position, select the Vibrato or Wide Vibrato menu item on the Tab Symbols
menu. The vibrato playback settings can be adjusted using the MIDI Setup Property Sheet
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Working With Rhythm Slashes
Rhythm Slashes are used to notate the chord strumming pattern of a rhythm guitar. Use the chord diagrams
in the Chord Diagram List that match the chord name above the slash to determine the fingering for the
slashes. The chord fingering for a chord name is strummed until the next chord name change in the
score. As an example, suppose you loaded a score with the following data:

Chord Diagram List

Rhythm Slashes in Score

In this case, you would strum the Am chord (x 0 2 2 1 0) using the notated rhythm slash pattern for the
duration of the first measure. At the start of the second measure, you would change to the F chord (1 3 3 2 1
1) and then strum the notated rhythm slash pattern for the duration of the measure.

You can only have one set of rhythm slash items per section. The rhythm slashes will always appear above
the top staff in the section. To insert a rhythm slash at the current position select the appropriate rhythm
slash from the Rhythm Slash menu.

Note: Rhythm Slashes can greatly reduce the size of Power Tab files. A rhythm slash is much smaller in size
than normal tablature numbering. If you've got a "chordy" guitar part in a score, you may want to try
converting it to rhythm slashes using the Rhythm Slash Conversion Tool

Single Note Rhythm Slashes

Rhythm Slashes can be used to represent a single note, and not just chords. This is useful for a rhythm guitar
that every once in a while plays a bass note or a little fill. To make the current rhythm slash a single note
rhythm slash, select the Single Note menu item on Rhythm Slash menu. The Single Note Rhythm Slash
dialog box appears:



The Single Note Rhythm Slash Dialog Box

To use a single note rhythm slash, the program needs to know two pieces of information. 1) What string the
note is on, and 2) what fret to place the finger on. String numbers are notated from 1 being high (high E on
standard guitar) to 6 being low (low E on standard guitar) The single note rhythm slash symbol will always
appear below the rhythm slash that it is being applied to. The string number will appear in a circle, with the
fret number beside it. Like a normal rhythm slash, a single note rhythm slash remains active until
the next chord name change. The following diagram illustrates single note rhythm slashes:

Single Note Rhythm Slash Example

This section would be played as follows (assuming standard guitar and tuning):

Play 4 open E notes on the Low E string ●   

Strum E5 chord ●   

Strum E chord twice●   

© 2000 Brad Larsen. All rights reserved. Terms of use.



The Chord Diagram List
The Chord Diagram List is used to store the chord diagrams that are used within the song. To open the
Chord Diagram List, select the Chord Diagram List menu item from the Guitar menu. The Chord Diagram
List Property Page will appear with the .

Note: The chord diagrams in the list are the diagrams used in the active score only

The Chord Diagram List Property Page

Adding A New Chord Diagram

To add a new chord diagram to the list, select the New Chord Diagram Button. The New Chord Diagram
dialog box will appear:



The New Chord Diagram dialog box

Construct the chord diagram voicing by clicking on the diagram. You can set the chord name by using the
Chord Name Button or by clicking on one of the suggested names from the list on the right side of the
dialog box.

Editing A Chord Diagram

Select the chord diagram that you wish to edit from the list and click the Edit Chord Diagram Button.
Manipulate the chord diagram as described in Adding a New Chord Diagram.

Removing A Chord Diagram

Select the chord diagram that you wish to remove from the list and click the Remove Chord Diagram
Button
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Chord Name Text
Chord Name Text is used to show the reader of the score what chord is currently being played (or implied). The Chord Name Text itself is not text,
but a numeric formula which is constructed using the Chord Name dialog box. This allows for easy customization of how chord names are displayed
(see "See Also" below). You may need to know a little about Chord Theory to work with Chord Names, but in most cases, you should be able to
construct the Chord Names on your own. Every chord name is made of four primary parts:

Chord Name Part Description
Key Identifies the key of the chord. This is a letter from A to G, including any accidentals. The accidental type can be

toggled by using the Sharp and Flat buttons, located to the right of the Key Selector.
Base Formula Identifies the "subfamily" of the chord. There are only 14 possible formulas the chord can belong to: major, minor,

augmented, diminished, 5th (power chord), 6th, minor 6th, dominant 7th, major 7th, minor 7th, augmented 7th,
diminished 7th, minor/major 7th and minor 7th augmented 5th.

Extensions/Additions/
Alterations

In order to create 9th, 11th and 13th chords, you must check the appropriate extension. EXTENSIONS CHECK
BOXES ARE ONLY ENABLED WHEN A 7TH CHORD FORMULA IS SELECTED. This is simply due to the fact that
extension chords must contain a 7th (they are extensions of 7th chords). As an example, let's go through the steps
to construct an Emaj11 chord. First click the E key from the key selector. Since the 11 is a major 11th, and you
know that 11ths are extensions of a 7th chord, select the maj7 formula from the formula list (if it were Em11, you'd
select m7).  At this time, the extension check boxes will become enabled.   Now check the 11th extension. You
should see Emaj11 in the preview window. Additions and alterations are essentially toggles.

Bass Note This is the note that is the lowest note played in the chord. When the bass note is the same as the key, it will not be
displayed. Otherwise the Bass Note will be tagged onto the end of the chord name.

To insert a chord name at the current position, select the Chord Name menu item on the Text menu. The Chord Name dialog box will appear:

The Chord Name dialog box

You can now construct the chord name using the controls on the dialog box. A preview of the chord name will appear in the preview pane.

Note:

If you need to insert a "No Chord" chord name, click the N.C. check box on the left side of the key list. The key list becomes disabled when
you check the N.C. check box.

●   

If you need brackets around the chord name (implication), click the () check box on the right side of the key list.●   

In some music scores, chord names may be notated in a manner something like the following: N.C.(Am). In order to achieve this, you must
select both the N.C. check box and the () check box.

●   

As a quick lookup function, all of the chord diagram chord names and the 20 most recently used chord names are listed in the listbox to the right.
Simple single click on the proper chord name, and it will automatically insert the chord name at the current position.
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'Floating' Text
Floating text can be inserted at the current position by selecting the Insert menu item on the Text menu. To
remove a floating text item, make sure the cursor is over the text item (the cursor will change to a text
cursor) and right click with the mouse. Select the Delete menu item.
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Special Text
Special Text items are essentially just pre-defined floating text items. There are two types of Special Text
items in Power Tab:

Italian Music Terms

Stores a list of most common italian music terms. All Italian Music Terms are displayed using an italic Times
New Roman font. To insert an Italian Music Term at the current position, select the Italian Music Term
menu item on the Text - Special menu. The Insert Italian Music Term dialog box will appear:

The Insert Italian Music Term dialog box

The music terms are categorized into five groups: The Pace of Music, The Acceleration of Music, Expression or
Force, Style in Performance and Miscellaneous. Select the proper category, then click the term you wish to
insert. The final step is to click the OK button.

Time Stamps

Time Stamps are used to notate the running time (min:sec) of the song at a particular point in the score. To
insert a Time Stamp at the current position, select the Time Stamp menu item on the Text - Special menu.
The Time Stamp dialog box will appear:



The Time Stamp dialog box

The edit box on the left represents the time in minutes, the edit box on the right represents the time in
seconds. One you have entered the proper time, click the OK button.

Since special text is just pre-defined floating text items, they can be edited and removed in the same manner
as normal floating text items.
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Editing Data
You can edit existing data at a position by holding down the Ctrl key while clicking on the toolbar for the data
type you want to edit. This technique will only work on a data type that is added using a dialog box (chord
name text, time signatures, etc.).
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Removing Data
To remove data at the current position, simply click on the toolbar button of the data type you wish to
remove. This will only work on data types that are added using dialog boxes (time signatures, tempo markers,
etc.).
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Triplets and Irregular Groupings

Triplets

In order to apply a triplet to a group of notes, you must first select the notes to be grouped.  You do this by
selecting the numbers on the tablature staff that you wish to apply the triplet to.  The following illustrates
creating a triplet:

Step 1 - Move the position indicator to the start of the group of notes you want to tripletize.

Step 2 - Click and hold the left mouse button, then move the mouse to the right until all the numbers you
want in the triplet grouping are within the selection rectangle (black rectangle).  You can release the left
mouse button now.

Step 3 - After you have the notes selected, click the triplet toolbar button (or select Triplet from the Notes
menu).  The selection rectangle will disappear and the notes will now be a part of a triplet grouping.

Note 1: You do not have to use 3 notes in order to apply a triplet, you can apply a triplet grouping to a
quarter note + an 8th note, or to 6th 8ths notes (which would act as a quarter triplet grouping), etc.

Note 2: Triplets in dual melody staff - In a staff that contains both a high and low melody, you can only group



notes within the same melody line (ie. notes on the low melody cannot be grouped with notes on the high
melody).  When grouping a bunch of notes that start on a position that contains both high and low melody
notes, make sure the position indicator is located at a note that is in the melody that you wish to group (ie. if
grouping a bunch of low melody notes, make sure the crosshairs on the position indicator have a low melody
note between them).

Irregular Groupings

Irregular Groupings are applied in the same manner as triplets.  

Step 1 - Move the position indicator to the start of the group of notes you want in the irregular grouping.

Step 2 - Click and hold the left mouse button, then move the mouse to the right until all the numbers you
want in the grouping are within the selection rectangle (black rectangle).  You can release the left mouse
button now.

Step 3 - After you have the notes selected, click the irregular grouping toolbar button (or select Irregular
Grouping from the Notes menu).  The Irregular Grouping dialog box will appear:

The Irregular Grouping Dialog Box

In the above example, we want to play six 16th notes in the time that four16th notes are normally played. 



The Irregular Grouping dialog box already contains these values, so you can click the OK button.  The
selection rectangle will disappear and the notes will now be a part of an irregular grouping.



MIDI Setup
To initialize the MIDI Setup, select the Setup menu item on the MIDI menu. The MIDI Setup Property
Sheet will appear. It has three property pages (tabs), each of which is described below: 

The Output Property Page - This is where you select the MIDI Output Device that you want Power
Tab Player to send the MIDI data to. A list of all available MIDI Output devices on the current machine
will appear in the Device drop down combo box. If there are no MIDI output devices on the current
machine, you cannot playback the data. Choosing the proper output device can make a great deal of
difference in the playback quality.

●   

The Output Property Page

The Playback Settings Property Page - This page is used to set the pitch wheel and other effects
that the MIDI output device will use during playback. The pitch wheel is a part of the MIDI output
device that simulates the bending/sliding of notes. Different MIDI devices may have a different pitch
wheel bending range. Some can only bend two half tones (steps), others are capable of bending over
24 half tones. The larger the pitch wheel range, the better the output will sound. There are four items
in a Power Tab score that can use the pitch wheel:

Bending - Bending of the strings.  The maximum bend allowed in Power Tab is three full steps,
so you therefore should have a MIDI output device that has a pitch wheel range of at least six
half steps in order for bending to work properly.

❍   

Shift/Legato Sliding - Sliding from one fret to another. The maximum slide allowed in Power
Tab is twelve full steps, so you therefore should have a MIDI output device that has a pitch
wheel range of twenty-four half-steps in order for this type of sliding to work properly. (Note
that most slides are only three/four half steps in length, so you can usually get away with a

❍   

●   



pitch wheel range of that size.)

Sliding In/Out - Sliding Into or Out of a note from "nowhere". These types of slides occur over
three half steps.

❍   

Tremolo Bar Diving - The maximum tremolo bar dip that can be performed in Power Tab is
seven full steps, so therefore you should have an MIDI output device that has a pitch wheel
range of fourteen half-steps in order for the tremolo bar effect to work properly.

❍   

You can test the current pitch wheel bend range by using the test buttons on the right hand side of the
page. Both buttons sound a note, the first is a note played normally without using the pitch wheel, the
second is a bent note played using the pitch wheel. Both notes should sound the exact same pitch.  If
the pitch doesn't sound the same, the pitch wheel doesn't support the current pitch wheel range.

Effects Levels - all effects levels use a setting from 1 to 127. A setting of 127 represents the
maximum level for the effect, and 1 represents the minimum level.

Vibrato - Controls the amount of vibrato used on normal vibrato items (wiggles) in the Power
Tab score.

❍   

Wide Vibrato - Controls the amount of vibrato used on wide vibrato items (angular jags) in the
Power Tab score.

❍   

Let Ring - Controls how long the notes are held during let ring items in the Power Tab score.❍   

The Playback Settings Property Page

Metronome Settings - This page is used to change the metronome setup. Select the MIDI percussion
patch (instrument sound) that you want to sound during each metronome click. The strong and weak
accent volume levels can also be set (ie. 4/4 time - click pattern is 1 - 2 -3 - 4, where 1 is strong
accent, the others are all weak). Strong accents should obviously have a much higher volume setting.
If you want the metronome to count-in the song before playback (recommended), you can click the

●   



"Enable Count-In Before Playback" check box. Similar to the main metronome clicks, you can also set
the MIDI percussion patch and volume level for the count-in clicks.

The Metronome Settings Property Page
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Importing MIDI Tracks
To import MIDI Tracks, select the MIDI Tracks menu item on the File -> Import menu. Follow the
instructions on the MIDI Import Wizard.
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Exporting to ASCII Text
To export the active score to ASCII text, select the ASCII File menu item on the File + Export menu. You'll
be asked where you want to save the file, and then the Export to ASCII Text File dialog box will appear:

The Export to ASCII Text File dialog box

Write Usage Warning - Places the following text passage at the start of the file: This file is the
author's own work and represents their interpretation of the song. You may only use this file for
private study, scholarship, or research. 

●   

Write Tablature Symbols Legend - Places a tablature symbol legend at the end of the file ●   

Open in Notepad after Export - Opens the exported file in Notepad after the export process is
complete

●   
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Exporting to HTML
To export the active score to HTML, select the HTML File menu item on the File + Export menu. You'll be
asked where you want to save the file, and then the Export to HTML File dialog box will appear:

The Export to HTML File dialog box

Write Usage Warning - Places the following passage at the start of the file: This file is the author's
own work and represents their interpretation of the song. You may only use this file for private study,
scholarship, or research. 

●   

Write Tablature Symbols Legend - Places a tablature symbol legend at the end of the file ●   

Open in Browser after Export - Opens the exported file in the default web browser after the export
process is complete

●   
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Exporting to MIDI
To export the active song to MIDI file (format 1), select the MIDI File menu item on the File + Export
menu. You'll be asked where you want to save the file.
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Exporting Sections To Bitmaps
Power Tab Editor allows for individual sections to be outputed to the Bitmap file format (.bmp). You can
output a section in the score to one of two places:

The Clipboard - This places a copy of the current section (in bitmap format) to the Windows
clipboard. It can then be pasted into a word processor or image editor. To output the current section to
the clipboard, select the To Clipboard menu item on the Output To Bitmap menu sub item on the
Section menu. After the section has been placed in the clipboard, the section will flash once to notify
the user the process has completed. 

1.  

To File - This saves a copy of the current section (in bitmap format) to disk. The file can then be
imported into a word processor or opened into an image editor. To output the current section to the
file, select the To File... menu item on the Output To Bitmap menu sub item on the Section menu.

2.  

Note:

To display a border around the outputted bitmap, select the When exporting to .bmp, draw a
border around the section checkbox item on the General Options Property Page.

●   
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Tablature Notation Options

The Tablature Notation Options Property Page

Notate whole step bends as "Full" as opposed to 1●   

Notate max. tremolo dive as "Full" as opposed to 7●   
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General Options
To change the General Options select the Options menu item on the View menu and click on the General
Options tab.

Reload last file on startup - Loads the last active file when the editor is started ●   

Autosave file after n minutes - Automatically saves the current song to disk after every n minutes.
To retreive an autosaved file, use The Recovery Tool 

●   

When exporting to .bmp, draw a border around the section - Draws a black frame around
exported bitmap data.

●   
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Printing Options
To change the Printing Options select the Options menu item on the View menu and click the Printing
Options tab.

Print Performance Notes - Prints the performance notes at the top of the first print-out page. ●   

Print Guitar Legend - Prints a legend for all guitars used in the score at the top of the first print-out
page. 

●   

Print Lyrics - Not implemented. ●   

Print Date/Time in Footer - Prints the current date and time on the bottom of each print-out page. ●   

Print Copyright - Prints copyright info at the bottom of the first print-out page.●   
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Chord Name Suffix Display Options
Power Tab is flexible enough that it will allow you to customize the way that Chord Names suffixes are
displayed. Chord Name suffixes can vary from publisher to publisher, you may like a particular style better
than others. To adjust the settings, use the Options menu item on the View menu. The Power Tab Options
property sheet will appear. At the top of the sheet, select the Chord Name Suffix Display Options tab. You
should see the following:

The Chord Name Suffix Display Options Property Page

There are nine suffixes that can be set, Major, Minor, Augmented, Diminished, Power Chord (5th), Add,
suspended 4th, altered (augmented) and altered (flatted). Each combo box has a list of the more common
styles used, but you are free to type in whatever you wish. All changes will automatically be reflected in the
score.
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The Chord Dictionary
The Chord Dictionary generates a list of chord diagrams for all possible chord names available in the Power Tab Editor. To open the Chord
Dictionary, select the Chord Dictionary menu item on the Tools menu. The Chord Dictionary will appear:

The Chord Dictionary

On the left side of the screen you can select the chord name that you wish to display chord diagrams for. (See the help topic Chord Name Text for
more info on constructing chord names). The tuning used to generate the chord diagrams can be selected via the Tuning Combo Box. Only the
tunings that are active in the current score's guitar setup are listed.

Choosing the Chord Diagram Fret Position

Only chord diagrams that have a "top fret" of that currently selected in the Fret Position Combo Box are displayed. This acts as a filtering device.
To view the chord diagrams at a different fret position, select the appropriate fret position from the combo box list.

Adding a Chord Diagram to the Chord Diagram List

To add a chord diagram to the chord diagram list, select the appropriate chord diagram from the list, and click the Add to Chord Diagram List
Button

Inserting a Chord Diagram Into the Current Score

To insert a chord diagram into the current position of the score, select the appropriate chord diagram from the list and click the Insert Button. The
insert button will only appear if you opened the Chord Dictionary from an empty position in the score.

Playing a Chord Diagram

If you have a chord diagram selected, you can listen to how it will sound during playback by pressing the Play Selected Chord Button



Chord Diagram Lookup

If you have a chord diagram/fingering and want to know the possible chord names for it, press the Chord Diagram Lookup Button. This will open
up a small diagram which you can construct the chord diagram with. All possible chord names will be listed on the right
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The Tuning Dictionary
The Tuning Dictionary is used to store a listing of commonly used tunings. To open the Tuning Dictionary
select the Tuning Dictionary menu item from the Tools menu.

The Tuning Dictionary

The Tuning Dictionary stores a list of tunings in a file called tunings.dat that resides in the \Data\ folder
where you installed the program. When loaded, the Tuning Dictionary displays all the tunings found in the file
in the Tuning List Control. Only the tunings found that match the current instrument type (3-7 string) will
be listed. When you change the instrument type (using the combo box at the top of the screen, located beside
the List Tunings for label), the tunings in the list will refresh themselves to match the instrument. You can
sort the tunings by Name or Tuning (spelling) by clicking on the Tuning List Headers.

Adding A Tuning

If you've got a tuning that isn't already listed in the tuning dictionary and you wish to store it, click the Add
Tuning Button. The New Tuning dialog box will appear:



The New Tuning dialog box

Tuning Name: Name given to the tuning. ie. Dropped-D, Open G, etc. ●   

Tuning Type: The type (# of strings) of tuning ●   

String 1 to n: Individual string pitches (C4 = middle C). String 1 represents the highest string in the
tuning 

●   

Off: The default musical note offset used by the tuning. The musical note offset is described here.●   

Every tuning must have a tuning name. You must also select which type of instrument the tuning is used for.
(3-7 string instrument). To change the notes of the tuning, use the tuning spin buttons.

Importing Tunings

To import tunings from another tuning file, click the Import Tunings Button. All tunings found in the foreign
tuning file that aren't listed in your tuning file will be added.

Editing A Tuning

To edit a tuning, click the Edit Tuning Button. The Edit Tuning dialog box will appear, where you can
change the tuning name, type and tuning notes, as described in Adding A Tuning.

Setting A Default Tuning

To save a tuning as the default, click the Default Tuning Button. This tuning will then become the default
tuning used by guitars that have the same number of strings as the tuning has tuning notes. Therefore, there
are 5 default tunings that can be saved, one each for 3, 4, 5, 6 and 7 stringed instruments. This comes in
handy if you're transcribing a lot of songs that aren't in standard tuning.



Removing A Tuning

To remove a tuning from the tuning file, click the Remove Tuning Button. You will be asked to confirm that
you want to remove the tuning.
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The Score Checker
The Score Checker is used to check the active score for errors. To move to where the error occured in the
score, simply double-click on the error in the list. The Score Checker will minimize and you can fix the error.
To open the Score Checker, select the Score Checker menu item on the Tools menu.

The Score Checker
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The Chord Identification Tool
The Chord Identification Tool is used to identify the chord (name) at the current position. It works on a single
position only (the future version will analyze entire scores, suggesting chord names throughout). To open the
Chord Identification Tool at the current position, select the Chord Identification Tool menu item on the Tools
menu. The Chord Identification Tool will appear: (Note: There must be at least one note at the current
position for the Chord Identification Tool to open)

The Chord Identification Tool

Overview

Once the Chord Identification Tool is opened, a list is immediately filled with all the chord names that Power Tab
knows the chord to be known as. Chord names that are more likely to be used are placed at the top of the list.
(Chord names that "fit" into the active key signature will contain an asterisk beside their name). A chord diagram
will display the voicing for the chord on the left side of the screen. If the voicing will not fit on the chord diagram
(too wide a range between frets), the chord diagram is not drawn.

Inserting A Chord Name Into The Score

To insert a chord name into the score, simply double click on the chord name you wish to use from the Possible
Chord Names list column on the right side of the dialog box. The tool will close and the chord name you selected
will be inserted above the position that was active before the Chord Dictionary was opened. If the chord name
you want to insert isn't listed, you'll have to insert the chord name manually as described under the Chord Name
Text help topic.



Chord "Homonyms" - B#, C or Dbb?

You'll note in the possible chord names list that there are 6 checkbox columns. These checkboxes are used to
select the display type for the chord key letter, and bass note letter in the chord name. Each of the twelve notes
in the letter scale may be written in three different ways (aside from G#/Ab):

B# = C = Dbb
Bx = C# = Db
Cx = D = Ebb
D# = Eb = Fbb
Dx = F = Fb
E# = F = Gbb
Ex = F# = Gb
Fx = G = Abb
G# = Ab
Gx = A = Bbb
A# = Bb = Cbb
Ax = B = Cb

The three checkboxes listed under the Key Display heading control how the key letter is displayed. For example,
in the above diagram (using the Bm/G name), the key display will control whether the Bm/G chord is displayed
as: checkbox 1) Axm/G, checkbox 2) Bm/G or checkbox 3) Cbm/G. The same type of idea applies to the bass
note of the chord (if the bass note is the same as the chord letter, the bass display checkboxes will be disabled).
In the above diagram (using Bm/G once again), the bass display will control whether the Bm/G chord is displayed
as checkbox 1) Bm/Fx, checkbox 2) Bm/G or checkbox 3) Bm/Abb.
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The Recovery Tool
If you were smart and had the Autosave Option turned on, you can recover your most recently saved work.
All "Autosaved" files are stored in the \Autosave\ subdirectory located in the \Power Tab\ directory
(where you installed the program during setup). These files are saved in the format Backup.xxx, where xxx is
a number 000 through 009 (.000 is the most recently saved file). You can access these files using the
standard File/Open method, but Power Tab has a quicker and more efficient way of doing it. From the Tools
Menu select the Recovery Tool menu item. The Recovery Tool Dialog Box will open:

The Recovery Tool Dialog Box

The Recovery Tool dialog box will list the last 10 Autosaved files (only the 10 most recently saved files are
stored), in chronological order. The title of the file, if it was set, will also be displayed. To re-load a file from
the list, simply use the mouse to select (highlight) the file from the list, and then click the OK button. The file
will be loaded into the editor, where you can rename and resave the file
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The Replacement Tool
The Replacement Tool is used to replace specific note duration patterns within the score. This tool will
primarily be used to touch up scores that have been imported via MIDI. To open the Replacement Tool
select the Replacement Tool menu item on the Tools menu. The Replacement Tool will appear:

The Replacement Tool

How To Use The Replacement Tool

Simply click on the note patterns that you wish to replace from the list (you can select more than one at a
time). The note pattern on the left of the equal sign will be replaced will the pattern on the right side of the
equal sign. For example, if you select the first replacement item in the list (1/4 + 1/8 triplet = 1/8 + 1/8) all
instances of 1/4 + 1/8 triplet found will be replaced with two 1/8 durations.

Note: The Replacement Tool effects the note durations only, the actual notes themselves do not change.

Determining What To Replace

There are 3 methods that are used to define what data is replaced:

Entire Score: This method will replace all matching data, from start of score to end, for all guitars in
the score. 

1.  

From Measure A to B: This method is used if you want to replace the data of a song, but not the
entire song. All matching data that exists between Measure A and Measure B (including the data in
both measure A and B) will be replaced. 

2.  

Selected Data: This method is used to replace the currently selected matching data. If no data was
selected before the Replacement Tool was opened, this option will be disabled. 

3.  
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The Rhythm Slash Converter Tool
The Rhythm Slash Converter Tool is used to convert data on the tablature staff into rhythm slashes. At
present time there is no way to convert rhythm slash data to tablature staff data. There are a number of rules
that must be followed in order for the conversion process to be successful:

The data that is to be converted must not contain a note duration of less than a 16th. Rhythm slashes
currently have a minimum note duration of a 16th.

●   

The data that is to be converted must not contain an irregular grouping other than a triplet. Rhythm
slashes are only capable of triplet irregular groupings.

●   

The data that is to be converted must not contain existing rhythm slashes. The conversion tool will not
overwrite slashes that already exist.

●   

All common data traits between the tablature staff data and rhythm slashes will be applied. This means that
arpeggios, staccatos, ties, muted strings, etc. will all be preserved during the conversion.

Notes:

Any position data that is invalid (ie. Has a min and max fret number difference greater than 5 [chord
diagrams only span 5 frets]) are converted to a muted rhythm slashes 

●   

All notes in successive positions must be tied in order for a rhythm slash tie to occur during the
conversion process

●   

To use the Rhythm Slash Converter Tool, select the Rhythm Slash Converter menu item on the Tools
menu. The Rhythm Slash Converter dialog box will appear:

The Rhythm Slash Converter Dialog Box

Determining What To Convert

There are 3 methods that are used that define what data is converted:

Guitar Track: This method will convert all data, from start of score to end, FOR ONE GUITAR TRACK.
The guitar currently selected at the top of the Rhythm Slash Converter Tool dialog box is the one
that will have it's data converted. 

1.  

From Measure A to B: This method is used if you want to convert the data of a guitar track, but not
the entire track. All data that exists between Measure A and Measure B (including the data in both
measure A and B) for the guitar currently selected at the top of the Rhythm Slash Converter Tool
dialog box will have it's data converted. 

2.  

Selected Data: This method is used to convert the currently selected data. If no data was selected3.  



before the Rhythm Slash Converter Tool was opened, this option will be disabled. This method may
end up converting more than 1 guitar's data and thus the currently selected guitar is irrelevant.
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The Shifter Tool
The Shifter Tool is a tool used to shift (both string-wise and fret-wise) the data on the tablature staff. It is a
very helpful tool for "cleaning up" imported MIDI data. To use the Shifter Tool, select the Shifter Tool menu
item on the Tools menu.

Shifter Tool dialog box

There are 2 types of shifts that can be performed:

String-wise Shift: In a string-wise shift, the actual pitch of the data being shifted DOES NOT
CHANGE, just the string(s) that the note(s) is/are played on. Negative values for string-shifts shift the
data downwards (from high to low in standard tuning), and positive values for string-shifts shift the
data upwards (from low to high in standard tuning). If any part of the data cannot be shifted (due to
pitch being too low or high for the new string), the string-shift will not occur (an example of this would
be trying to shift an open E chord - 0 2 2 1 0 0, downwards). Let's look at a simple example of a
string-shift:

1.  



Example of an E chord being string-shifted downwards one string

In the above example, the top passage represents an E chord played using the top 4 strings (x x 2 4 5
4). This is not a very popular position for playing an E chord, so the user has string-shifted the data
down 1 string, with the result being centered around the 7th/9th fret, a much more common
representation of the E chord. The notes sounded are exactly the same pitch, they are just played
using different strings. 

Fret-wise Shift: In a fret-wise shift, the pitch of the data being shifted DOES change. Negative values
for fret-shifts shift the data downwards (towards the nut) and position values for fret-shifts shift the
data upwards (towards the bridge). Essentially what you are doing when you perform a fret-wise shift
is transposing the data (adding and subtracting half-step values from the fret numbers). If any part of
the data cannot be shifted (due to pitch being too low or high for the string), the fret-shift will not
occur (an example of this would be trying to shift an open A chord - x 0 2 2 2 0, downwards). Let's
look at a simple example of a fret-shift:

2.  



Example of an A chord being fret-shifted upwards 3 frets, thus becoming a C chord

In the above example, the top passage represents an A chord played in open form (x 0 2 2 2 0). The
user has decided to notate the passage in C instead, and has fret-shifted the data upwards by 3 frets.
The notes now sound 3 half-steps higher than the original form.

Determining What To Shift

There are 3 methods that are used that define what data is shifted:

Guitar Track: This method will shift all data, from start of song to end, FOR ONE GUITAR TRACK. The
guitar currently selected at the top of the Shifter Tool dialog box is the one that will have it's data
shifted. 

1.  

From Measure A to B: This method is used if you want to shift the data of a guitar track, but not the
entire track. All data that exists between Measure A and Measure B (including the data in both
measure A and B) for the guitar currently selected at the top of the Shifter Tool dialog box will have it's
data shifted. 

2.  

Selected Data: This method is used to shift the currently selected data. If no data was selected
before the Shifter Tool was opened, this option will be disabled. This method may end up shifting more
than 1 guitar's data and thus the currently selected guitar is irrelevant.

3.  

Final Notes

It should be noted that you are not limited to using just a string-shift or just a fret-shift in the same shift
application. They are not mutually exclusive items. A great use for a combination string/fret shift is in a
standard blues/rock boogie run. A song playing an "E" boogie riff can easily be copied and shifted to an "A"
boogie by using a fret-shift of 5 upwards (E to A = 5 half-steps), combined with a string-shift of 1 upwards. It
can dramatically speed up the song creation process in riff-oriented songs. In the situation where you need to
shift only a single note within a chord, use the Shift Tab Numbers menu items on the Position menu.
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The Tonality Tool
The Tonality Tool is a tool used to help determine the tonality (key signature) of a song. To use the Tonality
Tool, select the Tonality Tool menu item from the Tools menu. The Tonality Tool dialog box will appear:

The Tonality Tool dialog box

Note: Before continuing, the reader should make sure he/she is familar with the concept of key signatures.

The Tonality Tool List Control displays a list of each of the possible keys that the analyzed data may "fit
into". For each key listed, the total number of notes found matching each element of the scale (from Tonic I
to Leading Note VII) is displayed. Beside the Key column is the Sign. column, which simply displays the key
signature in sharps or flats. The Total column at the far right of the list displays the total number of notes
analyzed in the data that fit into the key's scale. Only keys that have at least one note for each accidental in
the key are displayed.

Note: For minor scale's, the VII column actually represents the total note count for the RAISED 7th.

In the above illustration, the Tonality Tool suggests using the Key of A major. The scale of A major is made of
the following series of notes:

I II III IV V VI VII (raised)
A B C# D E F# G#

In the illustration, we see that the F# minor key contains the following data:

I II III IV V VI VII (raised) Total
261 626 132 48 975 54 294 2390

Each of the above numbers represent the number of notes found that match that note type (I - VII) within the
scale. The total is simply the total number of notes found in the analyzed data that fit into the scale. The



higher the note totals, the higher probability the song uses the scale. In the above sample, the Tonality Tool
found 261 As, 626 Bs, .... , 294 G#s, for a total of 2390 notes that fit into the scale of A major.

Note: There are some "black-box" adjustments that go into the sorting of the key probabilities, which is why
sometimes you'll see the totals not listed in sequential order. It is up to the music notator to determine the
best key to use for the song.

Determining What To Analyze

There are 3 methods that are used to define what data is analyzed:

Entire Score: This method will analyze all data, from start of score to end, for all guitars in the score
(including rhythm slashes). This is usually the first method to try when using the Tonality Tool. 

1.  

From Measure A to B: This method is used if you want to analyze the data of a song, but not the
entire song. All guitar data (including rhythm slashes) that exists between Measure A and Measure B
(including the data in both measure A and B) will be analyzed. This is a good method to use if a large
number of key signatures are returned when using the Entire Song method (there may be key changes
in this case). 

2.  

Selected Data: This method is used to analyze the currently selected data. If no data was selected
before the Tonality Tool was opened, this option will be disabled.

3.  

Once the proper data has been selected that is to be analzyed, click on the Analyze Button to view the
results.
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The ASCII Tablature File Fixer
The ASCII Tablature File Fixer is a tool that fixes up ASCII tablature files that appear jarbled due to improper
carriage return/linefeed usage. To use the ASCII Tablature File Fixer tool, select the ASCII Tablature File
Fixer menu item on the Tools menu. The ASCII Tablature File Fixer Dialog Box will appear:

The ASCII Tablature File Fixer Dialog Box

Fix a Single File - Fixes a single ASCII file●   

Fix an Entire Directory of Files - Fixes an entire directory/folder (plus subfolders) of ASCII files●   

Note:

All fixed files will be saved with the naming convention "filename_fixed.ext", where filename is the name of
the file and .ext is the extension
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Customizing The Tools Menu
Customizing the Tools Menu provides for faster access to "foreign" tools (ie. CD player, MP3 player, etc) that
are used when transcribing songs. To customize the tools menu, select the Customize menu item on the
Tools menu. The Customize dialog box will appear:

The Customize Dialog

Adding A New Custom Tool

To add a new custom tool, simply click on the Add Tool Button. A file dialog box will appear. Simply select
the name of the program on your hard drive that you wish to add to the list. Once you have selected the tool,
the path to the file will appear in the Command edit box. The name of the file will appear in the Name edit
box. This is the name that will appear on the Tools Menu. A maximum of 8 tools can be added to the tools list.

Removing A Custom Tool

To remove a custom tool, simply select the tool in the tools list, and then click on the Remove Tool Button.
A confirmation message will appear. Choosing Yes will remove the tool.

Moving A Tool's Position In The List

To shift the position of a tool in the tools list, use the Move Tool Up/Down Buttons. The ordering of the
tools in the tools list is reflected on the Tools Menu



The Tools Menu

Above is a diagram of how the Tools Menu would look given the data used in the diagram at the top of the
page. The custom tools you add will always appear at the bottom of the menu (above the Customize... menu
item).
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Appendix A - Keyboard Map
Note: Single note hot keys are case sensitive

Bold Text indicates hot keys that have been updated in the current version of the program

Keys Description
+ Increases the position width between notes on the current section
- Decreases the position width between notes on the current section

Ctrl + Up/Down
Arrow Shifts the current fret number up or down a string

Ctrl + 1 Copies the current section to the clipboard
Ctrl + 2 Copies the current positon to the clipboard

A Edits the current Song Attributes (title, artist, etc.)
B Inserts a Music Bar at the current position

Ctrl + C Copies the selected data to the clipboard
D Inserts a Musical Direction at the current position
F Edits the tablature and chord name fonts

Ctrl + G Goto a particular Measure
Ctrl + H Goto a particular Passage
Ctrl + I Opens the Import MIDI Tracks Wizard

N Adds a new section to the end of the score
Ctrl + N Opens the New Power Tab File dialog box
Ctrl + O Opens a Power Tab file
Ctrl + P Prints the current Power Tab file

R Inserts a Rehearsal Sign at the current position
Ctrl + S Saves the current Power Tab file to disk

T Inserts a Time Signature at the current position
Ctrl + Toolbar

Button
Edits the effect at the current position.  (applies to effects that are input via a dialog
box:  bends, tremolo bar, time signatures, music bars, etc.)

V Inserts a Volume Swell at the current position
Ctrl + V Pastes the current data in the clipboard into the score

End Moves to the end of the current staff
Ctrl + End Moves to the last section in the score

F2 Toggles the Guitar Score to display
F3 Toggles the Bass Score to display
F5 Plays the current song
F6 Pauses the current playback, or restarts the playback if already paused
F8 Stops the current song
F9 Opens the Chord Dictionary
F10 Opens the Tuning Dictionary
F11 Opens the Score Checker
F12 Opens the Chord Identification Tool

Home Moves to the start of the current staff
Ctrl + Home Moves to the first section in the score

Page Up Moves to the previous section
Page Down Moves to the next section
Spacebar Inserts a space at the current position



Shift + Up/Down
Arrow Toggles the note duration (from whole to 64th - up increases duration length)

Shift + Left/Right
Arrow

Toggles the dot and double dot (the "cycle" pattern using the right arrow is no dot -> dot
-> double dot)

Shift + Toolbar
Button

Applies the effect to all notes at the current position.   (applies to effects like hammer-on,
tie, mute, etc.)

Shift + Spacebar Removes the space at the current position
Shift + F2 Takes snapshot of current section, then places resultant bitmap on the clipboard
Shift + F3 Takes snapshot of current section, then saves resultant bitmap to file
Ctrl + X Cuts the currently selected data and places it on the clipboard
Ctrl + Y Redoes the last undone item
Ctrl + Z Undoes the last done item

Tab Moves to the next measure in the score
Shift + Tab Moves to the previous measure in the score

a Toggles the accent embellishment
b Inserts a Bend at the current position
c Inserts Chord Name Text at the current position
d Inserts a Dynamic at the current postion
e Makes the selected data a triplet grouping
f Inserts a standard music bar at the current position
g Inserts a Guitar In symbol at the current position
h Inserts a Hammer-On/Pull-Off at the current position
i Makes the selected data an irregular grouping
j Auto-justifies the positions on the current section
k Inserts a Key Signature at the current position
l Inserts a Legato Slide at the current position
m Inserts a Palm Mute at the current position
n Makes the current note a ghost note
o Inserts a Tempo Marker at the current position
p Inserts a tap symbol at the current position
s Inserts a Shift Slide at the current position
t Inserts Text at the current position
u Toggles the current note from/to low melody
v Inserts Vibrato at the current position
w Inserts Wide Vibrato at the current position
x Makes the current note muted
y Makes the current note tied
z Toggles the staccato embellishment
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F.A.Q. (Frequently Asked Questions)
When trying to tie the current note to a note that's at the end of the previous section, all I hear is a
beep and it won't let me tie the notes together.

1.  

During playback, the bent notes don't sound right: either they bend to the wrong pitch or they don't
bend at all

2.  

I can't seem to open up a Power Tab .98 format file. Why won't the Editor load these files?3.  

Is the Power Tab Editor free ware?4.  

What program was used to make the Power Tab Editor?5.  

What are the requirements to run the Power Tab Editor?6.  

Is there a way to turn off the standard notation so that all that's displayed is the tablature staff?7.  

I just installed the Editor and I get funny characters displaying where the music notes should be
displayed on the music staff.

8.  

Why can't I loop data during playback, or slow the song down so it's easier to learn?9.  

Can I create a link to the site, or keep a copy of the program(s) on my site for downloading purposes?10.  

Can I input music via the music staff instead of entering the tab numbers?11.  

How do I use the Chrontron winamp plugin?12.  

Can I create a score so that the chord diagrams are printed above the staff instead of at the
beginnning of the score?

13.  

How do I export a Power Tab file to .bmp/.gif/etc?14.  

Can I import ASCII tab into the Power Tab Editor?15.  

Why does the ASCII export suck so bad?16.  

Are you planning on releasing the Power Tab file format to the public?17.  

When trying to tie the current note to a note that's at the end of the previous section, all I
hear is a beep and it won't let me tie the notes together.

Power Tab Editor uses the active guitar(s) on both the current and previous staff to determine if it can
tie itself to a note to the previous section/staff. Gtr In symbols are used to "activate" guitars
throughout the score. If you haven't placed a Gtr In symbol in the score, no guitars are considered to
be "active". The easiest way to determine where you need to insert Gtr. In symbols in the score is by
using the Score Checker. It will display an error at each position where a Gtr In symbol is missing.
Once you've inserted the proper Gtr In(s) symbols, you should be able to tie the notes.

 

1.  

During playback, the bent notes don't sound right: either they bend to the wrong pitch or
they don't bend at all.

Pitch bending capabilities are dependent upon the sound card and MIDI output device(s) that come
with the card. MIDI output devices are internal synthesizers on the sound card that generate the MIDI
playback notes/sounds that you hear during playback. When you click the playback button in the
Power Tab Editor, it sends a stream of computer data (0s and 1s) to the MIDI output device, which it
interprets and then outputs to your speakers as synthesized sound.

The pitch bending (or pitch wheel) range is determined by the MIDI output device that is currently
selected in Power Tab Editor (see the MIDI Setup topic in this help file on how to change the current
MIDI output device). As far as I know, there is no way in code to determine the pitch wheel bending
range for a sound card. The best ways to determine how far your sound card can bend note pitch is to
a) look it up in your sound card manual (or visit the sound card companies web site) and b) test each
MIDI output device that's available until the bends sound right. If none of the MIDI output device's

2.  



sound proper, the sound card may have a small pitch bending range. Just as an aside, I have an AWE
64 standard from about 1997, and it allows pitch bends of 24 half steps, which allows for excellent
"bending" performance in Power Tab products.

 

I can't seem to open up a Power Tab .98 format file. Why won't the Editor load these files?

The Power Tab Editor isn't capable of reading .98 files. However, there is a converter available. The
Power Tab .98 to 1.0 file converter can be found at The Official Power Tab Web Site under the
Downloads link.

 

3.  

Is the Power Tab Editor free ware?

Yes. I can't guarantee that it will always be that way, but there's probably a 95% chance that it will
remain free ware. If it goes the share ware route, it will only cost about $10.

 

4.  

What program was used to make the Power Tab Editor?

Microsoft® Visual C++

 

5.  

What are the requirements to run the Power Tab Editor?

The requirements are listed under the Introduction topic of this help file

 

6.  

Is there a way to turn off the standard notation so that all that's displayed is the tablature
staff?

Currently, no. A version that will allow the standard music staff to be "hidden" during print out may be
implemented at a future time, depending on other priorities.

 

7.  

I just installed the Editor and I get funny characters displaying where the music notes
should be displayed on the music staff.

  The solution to this problem is discussed in the Knowledge Base Article Q000003 - "PRB: Music Notes
Not Displaying Properly"

 

8.  

Why can't I loop data during playback, or slow the song down so it's easier to learn?

The Editor was designed as an editing tool only. I found it to be too "busy"/crowded/fat and bloated for
actually sitting down and learning a song. What I've done is designed a separate program for this, the
Power Tab Player. It offers real-time tempo adjustment, looped playback and muting/soloing out of
particular guitars. You can download the latest version of the Power Tab Player from The Official Power
Tab Web Site under the Downloads link.

 

9.  

Can I create a link to the site, or keep a copy of the program(s) on my site for downloading
purposes?

Feel free to make a link to the site, and/or keep a copy of the program on your site.  If you want you
can use the banners under the Links area of this site.

 

10.  

Can I input music via the music staff instead of entering the tab numbers?11.  

http://www.crosswinds.net/members/~powertab/
http://www.crosswinds.net/members/~powertab/downloads.htm
file:///D|/Projects/VC++6/PowerTab/hlp/HTML Help/introduction.htm
http://www.crosswinds.net/members/~powertab/q000003.html
http://www.crosswinds.net/members/~powertab/q000003.html
http://www.crosswinds.net/members/~powertab/
http://www.crosswinds.net/members/~powertab/
http://www.crosswinds.net/members/~powertab/downloads.htm
file:///D|/Projects/VC++6/PowerTab/hlp/HTML Help/links.htm


No.  And it's on the bottom of the "to do" list at the moment.

 

How do I use the Chrontron winamp plug-in?

After you've installed the plug-in, open up Winamp.  Press Ctrl + P.  On the left side of the screen,
click on the DSP/Effect item that's under the Plug-ins tree node.  On the right side of the screen, you
should see a list item called "GMixon Chronotron Plugin".  Click on it.  You should see the plug-in
appear.  Adjusting the slider will adjust the speed of the song.

 

12.  

Can I create a score so that the chord diagrams are printed above the staff instead of at the
beginnning of the score?

No.  I'm looking to this, and will probably implement a "Print Chord Diagrams at top of score vs. Print
Chord Diagrams above staff" type printing option.

 

13.  

How do I export a Power Tab file to .bmp/.gif/etc?

You cannot export the entire score to .bmp, but you can export sections to .bmp.  Select the Output As
Bitmap menu item on the Section menu.  The current section will be exported to a bitmap file (or to
the clipboard if need be).  Gif and jpeg format may be implemented at a later time.  

 

14.  

Can I import ASCII tab into the Power Tab Editor?

Currently no, but it's near the top of the "to do" list.

 

15.  

Why does the ASCII export suck so bad?

Because I wrote it!  Try downloading v1.5 or up.  The ASCII export is much better in those versions.

 

16.  

Are you planning on releasing the Power Tab file format to the public?

No.  The Power Tab file format uses Microsoft's c++ classes for storage, which makes it tough for
people who don't have VC++ to decipher.  However, I am planning on/in the process of creating a
generic "Universal Tab Exchange File" format (which will be available to the public), that Power Tab will
be able to import/export.  If you wanted to create your own MIDI to Power Tab or ASCII to Power Tab
importer, you could write a program that generates a UTEF file from a MIDI/tab source, and then
import it into Power Tab.

17.  
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Appendix C - Power Tab On The Web
Web Site - The Official Power Tab Web Site is located at http://powertab.guitarnetwork.org.  There
you will find the latest news on Power Tab products, bug report forms, suggestion forms, links to
tablature, downloads and a mailing list.

●   

E-mail - The e-mail address for contacting me is powertab@guitarnetwork.org●   

There are also a number of direct links on the Help menu in the Power Tab Editor.

© 2000 Brad Larsen. All rights reserved. Terms of use.
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